SMART Response™ 2012
Interactive response system
User's guide
Product registration

If you register your SMART product, we'll notify you of new features and software upgrades.

Register online at smarttech.com/registration.

Keep the following information available in case you need to contact SMART Support.

Serial number: ________________________

Date of purchase: ________________________

FCC notice
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

IC RSS 210 notice
This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Trademark notice
SMART Response, SMART Notebook, SMART Board, SMART Sync, Senio, smarttech, the SMART logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Microsoft, Windows, Windows Vista, Internet Explorer, ActiveX, DirectX, PowerPoint and Excel are either registered trademarks or trademarks of Microsoft Corporation in the U.S. and/or other countries. Mac, Mac OS, Safari and Finder are trademarks of Apple, Inc., registered in the U.S. and other countries. Adobe, Flash and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the U.S. and/or other countries. Intel, Pentium and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the U.S. and other countries. ExamView is a registered trademark of FSCreations, Inc. All other third party product and company names may be trademarks of their respective owners.

Copyright notice
© 2007-2011 SMART Technologies ULC. All rights reserved. The use and copying of SMART Response assessment software is subject to a license agreement. Any other use is prohibited. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not represent a commitment on the part of SMART.

One or more of the following patents: US6632059; US6326954; US6741267; US7151533; US7757001; USD612396; USD616462; USD617332 and USD636784. Other patents pending.

February 2012
Before you use your SMART Response™ interactive response system, please read and understand the safety warnings and precautions described in this guide. These safety warnings and precautions instruct you in the safe and correct operation of the system and its accessories so you can prevent injuries to yourself and others or damage to the equipment. You must always ensure that the SMART Response system is being used correctly.

### NOTE

If you own a SMART product other than a SMART Response system, refer to the user’s guide that came with your product for relevant warnings and maintenance instructions.

## Safety information

### WARNING

- Failure to follow the installation instructions that ship with the SMART product could result in personal injury or damage to the product.

- When using your SMART Response system with a SMART Board® interactive whiteboard and projector, do not stare into the beam of light created by the projector. Instruct children not to look in the direction of, or stare at, this beam of light.

- Ensure that any cables extending across the floor to your SMART product are properly bundled and marked to prevent a trip hazard.

- To reduce the risk of fire or electric shock, do not expose the components to rain or moisture.

### CAUTION

- Use only the batteries provided or equivalent replacements. Do not attempt to recharge the batteries.
Do not install batteries with the polarity (+/-) reversed.

Do not dispose of batteries in a fire or incinerator.

Dispose of batteries according to the laws and regulations of your region. If you do not know the applicable rules for your region, consult the battery manufacturer.

Do not use abrasive erasers or harsh chemicals when cleaning SMART Response system hardware.

Do not open the receiver or clicker units to attempt repairs. Refer all service to authorized SMART service personnel.

**IMPORTANT**

You must connect the USB cable that came with your SMART product to a computer that has a USB compliant interface and that bears the USB logo. In addition, the USB source computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the SMART product.

If your SMART product requires replacement parts, make sure the service technician uses replacement parts specified by SMART Technologies or parts with the same characteristics as the original.

**Compliance**

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications to this equipment not expressly approved by SMART Technologies may void the user’s authority to operate this equipment.
# Contents

## Important information
- Safety information ................................................. i
- Compliance ......................................................... ii

## Chapter 1: About the SMART Response system
- Introduction ....................................................... 1
- Features ........................................................... 2
- Hardware – clickers and receivers .............................. 4

## Chapter 2: Getting started
- Using your SMART Response system ....................... 7
- Environmental requirements .................................. 9
- Computer requirements ........................................ 10
- Connecting hardware and activating SMART Response software ........................................... 11
- Activating SMART Response software ..................... 15
- Selecting how students answer questions .................. 18
- Starting SMART Response LE software the first time 21
- Asking instant questions ........................................ 23
- Setting up Teacher Tools ........................................ 24
- Creating a class list ............................................. 30
- Editing a class list ............................................... 37

## Chapter 3: Using SMART Response software
- About SMART Notebook software ......................... 42
- Creating assessments ........................................... 44
- Adding questions to the assessment ......................... 47
- Adding questions using the Insert Question wizard ..... 52
- Importing questions from a Word document ............. 55
- Importing questions from an XML or SQZ file .......... 57
- Importing questions from a PDF file ....................... 58
- Importing questions from ExamView HTML ............. 60
- Setting answers for imported questions ................. 63
- Tagging questions .............................................. 64

## Chapter 4: Starting and connecting to a class
- Before class begins ............................................. 66
- Starting a class .................................................. 67
## Contents

- Connecting to the class ................................................................. 71
- Disconnecting students from a class ............................................. 77
- Completing assessments ............................................................... 79

### Chapter 5: Using clickers ............................................................ 87
- About SMART Response PE clickers ........................................... 88
- About SMART Response LE clickers .......................................... 93
- About SMART Response XE clickers .......................................... 95
- Asking questions ........................................................................... 96

### Chapter 6: Reviewing, printing and exporting assessment results ......... 97
- Importing assessment results ....................................................... 98
- Reviewing assessment results ..................................................... 100
- Flagging results ........................................................................... 102
- Generating Student Performance reports .................................... 103
- Generating Class Performance reports ........................................ 105
- Printing and exporting questions and results ................................. 108

### Chapter 7: Maintaining your SMART Response system ..................... 113
- Preventing component damage ................................................... 113
- Changing the clicker batteries ....................................................... 114
- Resetting clickers ....................................................................... 115
- Receiver indicator lights ............................................................... 115
- Troubleshooting the receiver ........................................................ 116
- Other troubleshooting tips ............................................................. 118
- Troubleshooting SMART Response CE connection issues ............. 118

### Appendix A: Hardware environmental compliance .......................... 121
- Waste Electrical and Electronic Equipment Regulations (WEEE directive) ......................................................... 121
- Restriction of Certain Hazardous Substances (RoHS directive) ............................................................... 121
- Batteries ..................................................................................... 121
- Packaging .................................................................................... 122
- Covered electronic devices ............................................................ 122
- U.S. Consumer Product Safety Improvement Act ............................. 122
- California Air Resources Board – Airborne Toxic Control Measure .............................................................. 122
- Restriction of Certain Chemicals (REACH directive) ....................... 122

### Index ......................................................................................... 123
Chapter 1
About the SMART Response™ system

Introduction
The SMART Response™ interactive response system is an assessment tool that enhances learning. It facilitates summative and formative assessment by enabling you to pose a question before, during or after a lesson to find out whether students are on track. You can use the feedback to help shape the rest of your lesson.

Once you finish the lesson, create a question set with SMART Response assessment software to evaluate learning more formally. You can feel confident that the students have answered the way they intended, because they can verify and change their self-paced responses directly.

Teachers can easily add creativity to questions by combining text with images to make questions more dynamic. The SMART Response system comes with SMART Notebook™ collaborative learning software, and offers 6,000 learning objects that you can add to quizzes.

The SMART Response system also increases one-to-one interaction by enabling teachers to survey and engage students and to collect responses.

Integration with SMART Notebook SE (Student Edition) software
SMART Notebook SE software enables your students to connect to your class, take quizzes and assessments, respond to questions and submit their work. For more information on how students use SMART Notebook SE software with SMART Response CE interactive response software, see the SMART Notebook SE online Help.
### Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration with SMART Notebook software</td>
<td>Open SMART Response software from a tab in SMART Notebook software. With SMART Notebook’s Gallery of more than 6,000 items of graphic-rich content, you can add images and other multimedia content to your questions and/or assessments.</td>
</tr>
<tr>
<td>SMART Notebook Full Screen mode toolbar</td>
<td>When you put SMART Notebook software in Full Screen mode, SMART Response buttons for creating questions, running assessments and viewing results appear in the toolbar. You can use SMART Notebook software in Full Screen mode to reduce distractions while presenting your lesson.</td>
</tr>
<tr>
<td>SMART Notebook Transparent mode toolbar</td>
<td>When you put SMART Notebook software in Transparent mode, SMART Response buttons for creating questions, running assessments and viewing results appear in the toolbar. In Transparent mode you can use other applications and see supporting content while presenting your lesson.</td>
</tr>
<tr>
<td>Multiple assessment options</td>
<td>Compile questions for formative and summative assessment, prepare quizzes or exams in advance and ask spontaneous questions to gauge student comprehension at any point during a lesson.</td>
</tr>
<tr>
<td>Teacher Tools</td>
<td>Access, view and manage all assessment data in one location. This powerful tool enables you to create class lists and manage tests and quizzes.</td>
</tr>
<tr>
<td>Question variety</td>
<td>Teachers can ask different types of questions, including true or false, yes or no, multiple choice, multiple answer, numeric fraction or math expression and text answer.</td>
</tr>
<tr>
<td>Familiar user interface</td>
<td>SMART Response software’s intuitive software lets you create pages that have clear, contextual and concise information for users at any level of experience.</td>
</tr>
<tr>
<td>Math expression questions and intelligent grading</td>
<td>When you create an expression question with a correct answer, you can choose which intelligent expression grading option that SMART Response uses to determine which mathematically equivalent answers you want to accept as correct.</td>
</tr>
<tr>
<td>Monitoring students during and after the test</td>
<td>You can monitor how much time as elapsed for a quiz. Grades are immediately calculated after the test and displayed in graphical charts and numeric tables.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previewing results during an assessment</td>
<td>You can see what responses students have submitted during the assessment and get immediate feedback on how the class is doing.</td>
</tr>
<tr>
<td>Easy-to-view results</td>
<td>Display results in easy-to-view pie charts or graphs, which you can then insert on a SMART Notebook page for a closer view and to add your own notes in digital ink. You can also view results in detail, so you can see exactly how each student has answered.</td>
</tr>
<tr>
<td>Add or change correct answers to completed assessments</td>
<td>Using Teacher Tools, you can choose to accept a submitted answer as correct in addition to (or instead of) the original correct answer. SMART Response software calculates the students' grades after the changes.</td>
</tr>
<tr>
<td>Multiple print options</td>
<td>Print assessments as handouts so students can complete them at their own pace, or add comments to completed assessments that can be printed and used later as study guides.</td>
</tr>
<tr>
<td>Anonymous mode</td>
<td>Allows students to respond with complete anonymity. Students can use SMART Response software without signing in, or they can participate in an assessment using any clicker or Internet-enabled device, allowing you to gauge the group's understanding.</td>
</tr>
<tr>
<td>Integration with third-party question bank</td>
<td>SMART Response software is compatible with commonly used file formats, so you can easily import questions from other applications, including Microsoft® Word and PowerPoint®, PDFs and third-party question banks.</td>
</tr>
<tr>
<td>Integrated Gradebook</td>
<td>Through Teacher Tools Gradebook, you can build comprehensive student progress reports which can be as simple or as detailed as you need. Create high-level comparisons of class performance, specific reports based on tagged characteristics such as demographics or curriculum standards, or personalized reports on how individual students are doing.</td>
</tr>
<tr>
<td>Tagging</td>
<td>You can tag students and questions and automatically generate reports with comprehensive student and class performance breakdowns. You can also tag key words to describe various characteristics, correlate questions to standards and break down performance into a printable chart. In addition to creating custom tags, you can select tags from a comprehensive list of educational standards and cognitive level tags for the questions you create in SMART Notebook software. You can also add tags or change the tags to questions after you finish creating an assessment.</td>
</tr>
<tr>
<td>Reporting</td>
<td>In support of the educational standard and cognitive level tagging, 16 report types are available in Teacher Tools that enable teachers to analyze student performance. You can use 10 of these reports to reflect educational standard and/or cognitive level, instead of being limited to analysis by assessment. These reports also enable teachers to compare performance between their students and between their classes.</td>
</tr>
</tbody>
</table>
# Hardware – clickers and receivers

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio frequency (RF) technology</td>
<td>RF technology provides a reliable wireless connection between the student clickers and the central receiver. You don’t need a line of sight to the clickers, and the clickers and the receiver can connect within a 100’ (30 m) range.</td>
</tr>
<tr>
<td>Ergonomic design</td>
<td>Designed to fit comfortably in young hands or to lie flat on a desk. Even young students find the durable handheld clickers easy to use and comfortable to hold. Responding to questions is quick and easy.</td>
</tr>
<tr>
<td>French language support</td>
<td>Students can switch the PE clicker displays to support English and French languages.</td>
</tr>
<tr>
<td>Ability to input math expressions</td>
<td>XE clickers have dedicated buttons that enable students to enter complex math and science expressions.</td>
</tr>
<tr>
<td>Ability to enter symbols as well as letters with diacritics</td>
<td>In XE mode, you can enter common math and science symbols. You can also enter diacritics (letters with special symbols or accents).</td>
</tr>
<tr>
<td>LCD screen</td>
<td>The easy-to-read LCD screen has room to display several lines of text. Students can see whether responses have been sent, and they can review the status of their clicker’s battery power and network connection.</td>
</tr>
<tr>
<td>Descriptive icons</td>
<td>Icons on the LCD screen enable students to monitor the battery power and the network status of their clicker.</td>
</tr>
<tr>
<td>Extended battery life</td>
<td>Each clicker uses long-lasting AA or AAA batteries.</td>
</tr>
<tr>
<td>Easy connection</td>
<td>The receiver connects to a computer using a USB cable, and it doesn’t require an additional power adapter.</td>
</tr>
<tr>
<td>Multiple receiver support</td>
<td>Users can use multiple SMART Response receivers from one teacher computer enabling the support of larger classrooms and audiences.</td>
</tr>
<tr>
<td>Flexible installation</td>
<td>Receivers weigh just under 6 oz. (165 g) and easily mount onto walls, desks or tables.</td>
</tr>
</tbody>
</table>
Chapter 2
Getting started

Using your SMART Response system ................................................................. 7
Teacher Tools ...................................................................................................... 7
SMART Response system hardware .................................................................. 7
Using the interactive response system .............................................................. 8
Environmental requirements ........................................................................... 9
Temperature ...................................................................................................... 9
Humidity ........................................................................................................... 9
Water and fluid resistance ................................................................................ 9
Dust and scratching ......................................................................................... 9
Electrostatic discharge (ESD) .......................................................................... 9
Conducted and radiated emissions .................................................................. 9
Computer requirements ................................................................................... 10
Windows operating systems .......................................................................... 10
Mac OS X operating system software ............................................................. 10
Connecting hardware and activating SMART Response software ................ 11
Connecting receivers ..................................................................................... 11
Recommended height for mounting receivers ............................................... 11
Extending the USB cable .............................................................................. 13
Checking receiver status ............................................................................... 14
Checking clicker status ................................................................................ 14
Activating SMART Response software ......................................................... 15
Activating SMART Response CE software .................................................. 16
Activating SMART Response VE software .................................................. 17
Selecting how students answer questions ...................................................... 18
Multiple SMART Response devices mode limitations .................................... 20
Why don't I use Multiple SMART Response devices mode all the time? ....... 20
Starting SMART Response LE software the first time .................................. 21
Pairing student clickers ................................................................................... 21
Assigning clicker IDs .................................................................................... 22
Asking instant questions .............................................................................. 23
Setting up Teacher Tools ............................................................................... 24
Starting Teacher Tools ................................................................................... 25
Starting Teacher Tools in CE mode using SMART Sync Class List Server .... 25
## CHAPTER 2
Getting started

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a SMART Teacher file</td>
<td>25</td>
</tr>
<tr>
<td>Editing your SMART Teacher file</td>
<td>26</td>
</tr>
<tr>
<td>Adjusting privacy and alert options</td>
<td>27</td>
</tr>
<tr>
<td>Using Privacy mode</td>
<td>27</td>
</tr>
<tr>
<td>Changing alerts</td>
<td>27</td>
</tr>
<tr>
<td>Applying encryption methods</td>
<td>28</td>
</tr>
<tr>
<td>Configuring service ports</td>
<td>29</td>
</tr>
<tr>
<td>Creating a class list</td>
<td>30</td>
</tr>
<tr>
<td>Creating a class list in Teacher Tools</td>
<td>30</td>
</tr>
<tr>
<td>Importing a class list from Excel®</td>
<td>31</td>
</tr>
<tr>
<td>Creating class lists for all modes except LE</td>
<td>31</td>
</tr>
<tr>
<td>Creating class lists for LE mode</td>
<td>32</td>
</tr>
<tr>
<td>Importing the class list</td>
<td>33</td>
</tr>
<tr>
<td>Importing a class list from a CSV file</td>
<td>34</td>
</tr>
<tr>
<td>Creating class lists for all modes except LE</td>
<td>34</td>
</tr>
<tr>
<td>Creating class lists for LE mode</td>
<td>34</td>
</tr>
<tr>
<td>CSV file formatting</td>
<td>35</td>
</tr>
<tr>
<td>Tips for formatting CSV files for importing class lists</td>
<td>35</td>
</tr>
<tr>
<td>Using SMART Sync Class List Server class lists</td>
<td>36</td>
</tr>
<tr>
<td>Editing a class list</td>
<td>37</td>
</tr>
<tr>
<td>Editing student information</td>
<td>37</td>
</tr>
<tr>
<td>Adding students to a class list</td>
<td>37</td>
</tr>
<tr>
<td>Removing students from a class list</td>
<td>38</td>
</tr>
<tr>
<td>Tagging students</td>
<td>39</td>
</tr>
<tr>
<td>Changing a class's passing grade</td>
<td>39</td>
</tr>
</tbody>
</table>
Using your SMART Response system

Using the SMART Response interactive response system, you can perform planned or spontaneous student assessments in the same software you use to deliver your lessons—it integrates seamlessly with SMART Notebook collaborative learning software.

You can easily prepare exams in advance or spontaneously quiz students during a lesson and receive immediate responses from your class. Depending on the mode you're using, SMART Response software supports several different types of questions, including true or false, yes or no, multiple choice, multiple answer, text answers, and numerical fractions and expressions. You can import questions from third-party question banks, Microsoft® applications and other common programs.

After students submit their answers, you can see the results by percentage in a graphical format, which gives an accurate representation of the whole class’s performance, not just that of individual students.

Teacher Tools

Using Teacher Tools, you can access, view and manage all assessment data in one location. You can create class lists and set up, conduct and manage tests and quizzes. You can track each student’s progress over several assessments, and you can even tag questions with key words to evaluate test results and student performance in greater detail.

Teacher Tools makes it easy for you to keep everything organized. The easy-to-use management tool automatically files test results in the built-in gradebook. It also lets you manage your class lists and view performance reports and test scores.

The Teacher Tools Gradebook gives you quick access to test results, making it easy to prepare reports and conduct evaluations. Reports can be as simple or as detailed as you need. Create high-level comparisons of class performance, specific reports based on tagged characteristics such as demographics or curriculum standards, or personalized reports on how individual students perform. You can also create reports that show grades for the entire school year.

SMART Response system hardware

The SMART Response receiver and clickers use radio frequency technology to provide a reliable wireless connection between the student clickers and the central receiver. You don’t need a line of sight to the clickers, and the range is 100’ (30 m). The receiver verifies receipt of every signal and messages automatically re-send if they aren’t received.

Students find the handheld clickers easy to use and comfortable to hold. Students can easily read several lines of text on the large display screen. They can see if responses have been sent and can
review the status of their clicker's battery power and network connection.

**Using the interactive response system**

You can purchase SMART Response interactive response system software for both Windows and Mac computers that meet the minimum requirements. See *Computer requirements* on page 10 for information.

You can use SMART Response software's integrated SMART Notebook features on any computer, so you can take your laptop home to develop assessment questions without having to connect a receiver. You can then copy the assessment files to a classroom computer where you can run your assessments.

When you install SMART Response software, by default, the installation program installs SMART Notebook software, SMART Product Drivers and SMART Response software. SMART Response software includes Teacher Tools and menus that appear in the SMART Notebook software toolbar. You can use the software for free for 30 days after which you must activate the software.
Environmental requirements

Before installing or using your SMART Response interactive response system, review the following environmental requirements and compliance statements.

**Temperature**
SMART Response components can operate in the temperature range of 41°F to 95°F (5°C to 35°C). In addition, the product can withstand storage temperatures from -40°F to 120°F (-40°C to 50°C).

**Humidity**
SMART Response components can operate in up to 80% relative humidity, non-condensing.

**Water and fluid resistance**
SMART Response components are for indoor use only and don’t meet any salt-spray or water-ingress requirements. Don’t pour or spray any liquids directly onto SMART Response components. These liquids can get into areas where they can damage sensitive electronic components.

**Dust and scratching**
SMART Response components are for use in office and classroom environments, and they aren’t for industrial use where heavy dust and pollutants can cause malfunctions or impaired operation. They’re designed for pollution degree 1 (P1) as per EN61558-1, which is defined as “No pollution or only dry non-conductive pollution.”

**Electrostatic discharge (ESD)**
SMART Response components meet the requirements of EN61000-4-2 severity level 4 for direct and indirect ESD. No malfunction or damage up to 15 kV (both polarities) with a 330 ohm, 150 pF probe (air discharge). Unmated connectors meet 8 kV for direct (contact) discharge.

**Conducted and radiated emissions**
SMART Response hardware’s narrowband radiated electric field meets the limits for Class B performance, as defined in EN55022/CISPR 22.
Computer requirements

Windows operating systems

- Pentium® 4 or later processor
- 1 GB of RAM (2 GB or more recommended)
- 400 MB of free hard disk space
- Windows® XP SP3, Windows Vista® SP2 or Windows 7 operating system
- Internet Explorer® Internet browser 6.0 or later
- Adobe® Flash® Player 11.1 or later Firefox® plug-in
- Adobe Flash Player 11.1 or later ActiveX® control for SMART Notebook software
- Adobe Reader® 8.0 or later
- Microsoft DirectX® technology 8.1 or later (required for SMART Video Player)

Mac OS X operating system software

- 1.5 GHz Intel® or later processor
- 1 GB of RAM (2 GB or more recommended)
- 500 MB of free hard disk space
- Mac OS X 10.6 to 10.7 operating system software
- Adobe Reader 8.0 or later
- Safari application program 4.0.2 or later
- Adobe Flash Player 11.1 or later plug-in

NOTES

- 1 MB = 1024² bytes, 1 GB = 1024³ bytes.
- SMART Response assessment software runs on 32-bit and 64-bit operating systems.
Connecting hardware and activating SMART Response software

To send information to and receive information from SMART Response clickers, you must connect the SMART Response receiver to your computer. You can then check the receiver’s status in Teacher Tools.

**IMPORTANT**

You must activate your SMART Response software within 30 days of installation. SMART Response software automatically activates when you connect your SMART Response receiver. If the activation is not successful, use the manual procedure in this section to find your license code and activate the software.

**NOTE**

If you’re using SMART Response software in CE or VE mode, which doesn’t require a receiver, see Activating SMART Response CE software on page 16 or Activating SMART Response VE software on page 17 for instructions.

Connecting receivers

SMART Response receivers support up to 100 clickers each. You can connect more than one receiver to your computer to support larger classes.

**IMPORTANT**

- Do not connect the receiver to your computer until after you install SMART Response software.

- For operating safety and to prevent damage to the receiver, connect its USB connector only to a computer that has a USB compliant interface and that bears the USB logo. In addition, the USB source computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or UL mark(s) for CSA/UL 60950.

- The receiver has a USB 2.0 full-speed peripheral interface that runs at speeds of up to 12 Mbps. The unit works with USB 2.0- and USB 1.1-compliant USB interfaces.

Recommended height for mounting receivers

Unlike infrared devices, SMART Response receivers don’t require an unobstructed line-of-sight transmission path, such as that required by infrared devices. You can operate SMART Response
over longer distances if you minimize interference, signal reflections and the number and size of objects between the receiver and the clickers.

Choose a location for the receiver that’s as high as possible and in plain view of the students’ clickers. For permanent installations, use a USB extender to mount the receiver high on a wall. To minimize interference from other radio-frequency equipment, position the receiver away from other wireless products, such as 2.4 GHz routers and cordless telephones.

⚠️ WARNING
To prevent product damage or personal injury, route the USB cable where it will not be stepped on or tripped over.

To connect the receiver

1. Position the receiver in an unobstructed location away from other wireless products, such as 2.4 GHz routers and cordless telephones.
   ○ For temporary installations, place the receiver on top of your desk.
   ○ For permanent installations, mount the receiver on a wall or on the front of a piece of furniture using two screws (not provided).

Orient the receiver with the long side or edge facing the class as shown.
2. Insert the receiver’s captive USB cable connector into an available USB receptacle on your computer.

The Ready light on the receiver turns on to indicate that the receiver is receiving power.

**NOTE**

After you connect a receiver, if a message appears asking you to restart your computer, restart your computer.

On Windows computers, the first time you connect the receiver, a balloon message appears from the notification area indicating that new hardware has been detected.

**IMPORTANT**

If the balloon message indicates that Windows is starting to try to locate a driver from the Microsoft website, stop the search. If Windows does not find the driver on your computer, you did not install SMART Response software. Install the software and repeat the above procedure.

3. See *Checking receiver status* on the next page to verify that the receiver is working properly.

**Extending the USB cable**

If the provided 6’ (1.8 m) USB cable attached to the receiver isn’t long enough, use active USB extender cables, USB extenders or hubs.

This graphic shows the SMART active USB extension cable (Part No. USB-XT).

In some cases, you can use up to four cables to extend the length to about 80’ (25 m), which is the limit of the USB specification. Passive USB extension cables aren’t supported.

Alternatively, USB extenders that use Cat 5 cabling can extend the range to approximately 325’ (100 m) at a much higher cost. The more economical SMART CAT 5 USB extender (Part No. CAT5-XT-1100) can extend the USB connection up to 130’ (40 m) using an RJ45 Cat 5 cable.

Impedance mismatches and poor connections can cause signal degradation and performance problems.

**NOTE**

Some computers use internal active hubs to provide more USB receptacles. These internal hubs can limit the number of USB extenders you can use and the length of the Cat 5 cable you can use.
Checking receiver status
If you connected the receiver, you're ready to start a class session. You can check the receiver’s communication status at any time using the following procedure.

To check the receiver’s status
1. Click the SMART Response icon \( \text{icon} \) in the Windows notification area or Mac menu bar.
   A message appears below the Configure Devices heading indicating how many receivers are connected.
2. Click the icon below the Configure Devices heading.
   Teacher Tools starts.
   The Devices window appears showing a status message.
3. If a “Your SMART Response receiver is connected and working” message appears, the SMART Response receiver is connected and communicating with the SMART Response software. The receiver name appears below the Devices button.
   Click My Receiver to display the classroom name and the make, model and hardware ID (MAC address) of the receiver. If you have more than one receiver, My Receiver appears once for each receiver connected.
   OR
   If a “Your SMART Response receiver is not connected” message appears, the SMART Response receiver isn’t connected or isn’t working properly. The receiver name doesn’t appear below the Devices button.
   Check the receiver connections or repeat the receiver installation. See Connecting receivers on page 11.

Checking clicker status
You can check the status of each clicker in your classroom and, if you have more than one receiver, determine which receiver the clicker is connected through.

To check clicker status
1. Click the SMART Response icon \( \text{icon} \) in the Windows notification area or Mac menu bar.
   A message appears below the Configure Devices heading indicating how many receivers are connected.
2. Click the icon below the Configure Devices heading.

Teacher Tools starts.

The Devices window appears showing a status message.

If a "Your SMART Response receiver is not connected" message appears, the SMART Response receiver isn’t connected or isn’t working properly. The receiver name doesn’t appear below the Devices button. See Checking receiver status on the previous page to troubleshoot the receiver connection.

3. Click My Receiver to display the classroom name and the make, model and hardware ID (MAC address) of the receiver. If you have more than one receiver, My Receiver appears once for each receiver connected.

4. Select the Clickers tab.

A list of clickers connected through the receiver appears. Each row in the list displays the student name, the clicker's hardware ID or MAC address, the battery capacity and the signal strength.

### Activating SMART Response software

You must activate your SMART Response software within 30 days of installation. SMART Response software automatically activates when you connect your receiver.

- If you are using SMART Response software in CE mode, see Activating SMART Response CE software on the next page.
- If you are using SMART Response software in VE mode, see Activating SMART Response VE software on page 17.

### NOTES

- You must connect your computer to the Internet and connect the SMART Response receiver to your computer before you can activate the software.
- After you find your license code, you don’t need to connect the SMART Response receiver to the other computers that you want to activate SMART Response software on.

After you complete the following procedure to find your license code, you can use the code to activate SMART Response assessment software on other computers, as outlined in the License tab in the About SMART Response dialog box.
To find the license code after the software is activated

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select About SMART Response.
2. Record the license code that appears on the Description tab.

To activate SMART Response software on other computers

1. On the other computer, click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Check for Updates and Activation.
   
   The SMART Product Update dialog box appears and displays the time remaining in your software's evaluation period.

**NOTE**

If your SMART Response software is already activated, the Status (Days Left) column shows Activated beside SMART Response.

2. Click Activate.
   
   If your 30 day evaluation period has expired, the SMART Response Software Evaluation Expired dialog box appears. Click Activate Now.
   
   If you are within the 30 day evaluation period, the SMART Response Software Evaluation dialog box appears and displays the time remaining in your software evaluation period. Click Activate Now.

3. Type your license code and e-mail address, and then click Next.
   
   Your SMART Response software activates.

Activating SMART Response CE software

You must activate SMART Response software within 30 days of installation. After you install the software, use the following procedure to activate it.

To activate SMART Response CE software

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Check for Updates and Activation.
   
   The SMART Product Update dialog box appears and displays the time remaining in your software's evaluation period.
activating SMART Response VE software

You must activate SMART Response within 30 days of installation.

To activate SMART Response VE software

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Check for Updates and Activation.

   The SMART Product Update dialog box appears and displays the time remaining in your software's evaluation period.

   NOTE

   If your SMART Response software is already activated, the Status (Days Left) column shows Activated beside SMART Response.

2. Click Activate.

3. Type your product key in the text box, select the I accept check box, and then click Next.

   NOTE

   If you don't have a software license, contact your authorized local reseller through smarttech.com/where.
Selecting how students answer questions

Students can answer questions using one of these options:

- SMART Response / Senteo clickers
- SMART Response PE clickers
- SMART Response LE clickers
- SMART Response XE clickers
- SMART Notebook SE software on student devices
- SMART Response VE using Internet-enabled devices
- Multiple SMART Response devices, optionally including SMART Response VE and SMART Response / Senteo or SMART Response LE devices

Each of these options has a corresponding mode in SMART Response software. The first time you plug in a SMART receiver, SMART Response software prompts you to select the operating mode. Subsequently, you can select the appropriate mode for the devices in your classroom using the SMART Response Setup Tool.

**NOTES**

- If you have more than one type of SMART Response responding device in your classroom, you can choose Multiple SMART Response devices mode, or you can choose the mode that matches the type of device you’re using, and then use only that type of device while in that mode.

- Some question types aren’t available in all responding modes. See *About question types* on page 47 for more information.

- Students can use SMART Response PE, SMART Response LE or SMART Response XE clickers, SMART Notebook SE (SMART Response CE) or Internet enabled devices (SMART Response VE) while SMART Response is in Multiple SMART Response devices mode, but there are some limitations. See *Multiple SMART Response devices mode limitations* on page 20 for more information.
To open the SMART Response Setup Tool on a Windows computer

1. Close SMART Notebook software and Teacher Tools if they're running.

2. Click the SMART Response icon in the Windows notification area, and then select Setup Tool.

   The SMART Response Setup Tool window opens.

To open the SMART Response Setup Tool on a Mac computer

1. Close SMART Notebook software and Teacher Tools if they're running.

2. Click the SMART Response icon in the Mac menu bar, and then select Setup Tool.

   The SMART Response Setup Tool window opens.

To select how students answer questions

1. Open the SMART Response Setup Tool.

2. Select from the following options:

   ○ SMART Response LE
   ○ SMART Response XE
   ○ SMART Response VE
   ○ SMART Response PE
   ○ SMART Response / Senteo
   ○ SMART Notebook SE
   ○ Multiple SMART Response devices
     ○ I have students using SMART Response VE
     ○ I have students using SMART Response / Senteo or SMART Response LE

NOTES

○ Classes that are running stop automatically.

○ The SMART Notebook SE option isn't currently available for Mac OS X operating system software.

○ If you select SMART Response / Senteo or SMART Response LE in Multiple SMART Response devices mode, Text answer questions aren't available.
3. Click **OK**.

A message appears stating that your setup has changed. If you switch to SMART Response VE or if you select the **I have students using SMART Response VE** option in Multiple SMART Response devices mode, a message appears asking you to accept the terms of use. Click **I Accept**.

When you start SMART Response software, your students can answer questions using the device(s) you selected in step 2.

**Multiple SMART Response devices mode limitations**

In addition to using any available SMART Response clickers, students can use SMART Notebook SE software (SMART Response CE) or Internet enabled devices (SMART Response VE) while SMART Response is in Multiple SMART Response devices mode. This can be particularly useful if you have a variety of responding devices in your class.

**IMPORTANT**

You must be licensed to use all the devices you want to use in Multiple SMART Response devices mode. See **Activating SMART Response software** on page 15.

**Why don't I use Multiple SMART Response devices mode all the time?**

When in Multiple SMART Response devices mode, SMART Response software features are limited to those that all modes share.

The following are examples of limitations when in Multiple SMART Response devices mode:

- Students are unable to answer SMART Response XE math expression questions.

- If you select the SMART Response LE option when you select Multiple SMART Response devices mode, all clicker users must use the Clicker ID to sign in.

- Students can only answer the first question of an assessment when they use SMART Response LE clickers.

- Students are unable to answer text questions, multiple answer or mathematics questions when they use SMART Response LE clickers.
Starting SMART Response LE software the first time

You can use SMART Response LE in two modes: Anonymous mode and Sign-in mode. See About Sign In and Anonymous modes on page 67 for information about the operating modes.

Before you can use SMART Response LE in your classroom in Anonymous mode, you must

- assign a classroom name to the receiver, which you can do by creating a .teacher file, or by starting an assessment in SMART Notebook software.
- pair the students’ clickers with the SMART Response receiver.

To use SMART Response LE in Sign-in mode, in addition to the above, you must

- assign clicker IDs to each student’s clicker (which you can do when you pair the clickers with the receiver).
- create a class with a class list containing the clicker IDs.

NOTES

- You’re unable to assign a classroom name while you install SMART Response software. You can create a classroom name only after the software is installed and Teacher Tools starts for the first time.
- If you created a .teacher file on another computer, you can copy it to your computer and open it instead of creating a new file.

Pairing student clickers

IMPORTANT

You must connect the receiver and start a class before you can pair the clickers with the receiver.

To pair clickers with the SMART Response receiver

1. If a class isn’t running, start Teacher Tools. See Starting Teacher Tools on page 25.

   Teacher Tools appears.
2. Select **Anonymous Mode**, and then click **Start Class**.
   The receiver’s Power light flashes and then turns solid green. The receiver’s Transmit light flashes green.

3. Press the clicker’s **Power** and **Menu** buttons simultaneously for two seconds.
   **Teacher Mode** appears on the screen.

4. Using the clicker’s **Up** and **Down** buttons, select **Scan & Pick**, and then press **Enter**.
   The clicker searches for available classrooms.

5. Use the clicker’s **Up** and **Down** buttons to select your class from the list, and then press **Enter**.
   If your connection is successful, a “Paired With RCV” message appears.

6. Use the **Up** and **Down** buttons to select **Exit**, or hold down the clicker’s **Power** button to turn off the clicker.

7. Repeat steps 3 through 6 for the rest of your clickers.

You’re now ready to start a class and ask questions in Anonymous mode. See *Asking instant questions* on the next page to ask single questions, or see *Adding questions using the Insert Question wizard* on page 52 to create assessments.

**Assigning clicker IDs**
Before your students can connect and use their clickers, you must program each student’s clicker with a unique clicker ID number. When your students connect to a class, SMART Response software checks their clicker ID’s against the class list to determine whether they are valid members of the class.

If their clicker IDs aren't in the class list, the clickers don't connect.

To program clicker IDs into the clickers
1. If the clicker is turned on, press the clicker’s **Power** button to turn it off.

2. Press the clicker’s **Power** and **Menu** buttons simultaneously.
   **Teacher Mode** appears on the clicker’s screen.

3. Use the **Up** and **Down** buttons to scroll to **Clicker ID**, and then press **Enter**.
4. Use the **Up** and **Down** buttons to select a unique number between 1 and 199, and then press the **Menu** button.

**IMPORTANT**
Each clicker’s ID must be unique and must correspond to the student’s clicker ID in your class list. See *Creating a class list* on page 30 for information.

5. Use the **Up** and **Down** buttons to scroll to **Exit**, and then press **Enter**.

The clicker starts and is ready to use.

6. Repeat steps 1 to 5 for every clicker in your class.

### Asking instant questions

Use the Instant Question feature to introduce the SMART Response interactive response system to your students. Instant questions are individual questions you ask spontaneously—they aren't part of an assessment. When you use the Instant Questions feature, you’re unable to type a question or assign a correct answer.

You can ask an instant question verbally, write or type it on an interactive whiteboard and add objects directly onto the SMART Notebook page.

**NOTE**
Ensure that you start your class and that all students are connected before you ask an instant question.

1. **To ask individual questions using the Instant Question feature**
   1. Click the **SMART Response** icon in the Windows notification area or the Mac menu bar, and then select **Open Notebook Software**.
      
      A blank SMART Notebook page appears.
   
   2. Click the **Insert Question** icon on the toolbar.
   
   3. Click one of the **Instant Question** buttons.
      
      The **Instant Question** dialog box appears asking whether you want to insert the question on this page or on a new page.
4. Select one of the options.

**TIP**

If you want to use the same option by default, select the *Always perform this action* option. You can change the default in the *Preferences* menu.

A SMART Notebook page appears showing the possible answers to the question. The *Response* tab changes to *Single Question*, and the *Progress* button is selected.

The question starts automatically and appears on the student's display.

**NOTE**

If you haven't started a class, a message appears asking you to select a class. Select a class, and then click *Start Class*.

5. Present your question to the class.

6. After all students answer the question, click *Stop this question*.

7. To save the results, click *Save*.

   To add another question without clearing the results of the previous question, don't click *Clear*, and then repeat steps 2 to 6.

---

**Setting up Teacher Tools**

With Teacher Tools, you can

- check the status and performance of the receivers, clickers and students.
- select Sign In mode or Anonymous mode of operation.
- manage class lists.
- start classes so that students can sign in.

When you open Teacher Tools for the first time, you create a SMART Teacher file. You can later edit the SMART Teacher file and adjust the privacy options.
Starting Teacher Tools

When you start Teacher Tools for the first time, it opens to the Welcome to Teacher Tools view where you can create a SMART Teacher file, manage class lists, generate class or student performance reports and perform many other tasks.

- If this is the first time you're starting SMART Response software in LE mode, see Starting SMART Response LE software the first time on page 21 for information.

To start Teacher Tools

Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select the icon below the Teacher Tools heading.

Teacher Tools appears in Gradebook view.

NOTE

If SMART Notebook software is open, you can also start Teacher Tools by selecting Response > Teacher Tools.

Starting Teacher Tools in CE mode using SMART Sync Class List Server

When SMART Response software is in CE mode (using SMART Notebook SE software) and connected to a SMART Sync Class List Server, and you start Teacher Tools, a Welcome dialog box appears. You can select one of the teacher names in the dialog box to load the Administered Teacher's class information into Teacher Tools. See Using SMART Sync Class List Server class lists on page 36 for more information.

Creating a SMART Teacher file

If you want to save all of your class lists and assessment results, you need to create a SMART Teacher file. Your SMART Teacher file also enables your students to find and connect to your classes when they connect in Sign In mode.

If you need to, you can create additional SMART Teacher files after you create the initial one.

To create a SMART Teacher file the first time you use SMART Response software

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select the icon below the Teacher Tools heading.

   The Welcome to Teacher Tools wizard appears.
NOTE
The wizard appears only if you haven't created a SMART Teacher file.

2. Type your name and other information in the text boxes. The Save button is unavailable until you provide all the required information.

3. Click Save.

A Save As dialog box appears.

4. Type a file name, and then click Save.

The .teacher file saves and the Gradebook window appears displaying the teacher’s name.

To create an additional SMART Teacher file

1. Start Teacher Tools. See Starting Teacher Tools on the previous page.

Teacher Tools appears.

2. Select File > New.

The Gradebook Information screen appears.

3. Type your information in the text boxes, and then click Save.

4. Browse to where you want to save your SMART Teacher file, and then click Save.

Editing your SMART Teacher file
The first time you started SMART Response Teacher Tools, you created a SMART Teacher file to let your students find and connect to your class. See Creating a SMART Teacher file on the previous page.

You can use the following steps to change the information in your SMART Teacher file.

To edit your SMART Teacher file

1. Start Teacher Tools. See Starting Teacher Tools on the previous page.

Teacher Tools appears.

NOTE
You're unable to edit your classroom name if a class is running.

2. Click Edit beside the Gradebook name.
The *Edit Gradebook Information* window appears.

3. Edit the information, and then click **Done**.

### Adjusting privacy and alert options

You can set the level of student information that appears on your display and define whether you want student sign-in and sign-out alerts to appear.

#### Using Privacy mode

By default, SMART Response software displays student information such as ID numbers and grades. If you don't want to display sensitive information in front of your class you can turn Privacy mode on.

- **To hide private information**
  
  Click the **Privacy: Off** button in the upper right corner of the screen.

- **To display private information**
  
  Click the **Privacy: On** button in the upper right corner of the screen.

#### Changing alerts

You can set SMART Response software to display an alert message on your screen when students sign in or out.

- **NOTE**
  
  Alerts appear only when the SMART Response Desktop menu is running.

- **To set sign-in and sign-out alerts**
  
  1. Start **Teacher Tools**. See *Starting Teacher Tools* on page 25.

  **Teacher Tools** appears.

  2. Select **Edit > Preferences** (Windows computers) or **Teacher Tools > Preferences** (Mac computers) from the menu bar.

  The **SMART Response Preferences** dialog box appears.

  3. Click the **Alerts** tab.

  4. Select or clear the check boxes for the alerts you want to display or hide, and then click **OK**.
Applying encryption methods
You can set SMART Response CE software to use SSL or Diffie-Hellman encryption. SSL encryption allows other programs to access SMART Response CE software. Diffie-Hellman encryption (the default method) doesn’t allow other programs to access SMART Response CE software.

**NOTES**
- The system administrator can override this setting.
- You must put SMART Response software in SMART Notebook SE mode or Multiple SMART Response devices mode to configure the encryption method.

To apply an encryption method
2. Select **Edit > Preferences** (Windows computers) or **Teacher Tools > Preferences** (Mac computers) from the menu bar.
   - The SMART Response Preferences dialog box appears.
3. Click the Encryption tab.
4. Select **Diffie Hellman** or **SSL Digital Certificate** from the **Method** drop-down list.
   - If you selected **SSL Digital Certificate**, additional options appear:
     - Select **Automatically generated certificate** if you want SMART Response CE software to generate and use a security certificate.
     - Select **Imported certificate**, and then browse to and select the certificate you want to import, to use an existing certificate.
5. Click **OK**.
Configuring service ports
You can specify which ports SMART Notebook SE software uses for the file data channel and encrypted data channel, or you can set the software to use random ports. Use the following procedures to configure SMART Response CE software to use the same port configuration.

**IMPORTANT**
You must put SMART Response software in SMART Notebook SE mode or Multiple SMART Response devices mode to configure the service ports.

**To specify the service ports**
1. Start **Teacher Tools**. See *Starting Teacher Tools* on page 25
   
   *Teacher Tools* appears.

2. Select **Edit > Preferences** (Windows computers) or **Teacher Tools > Preferences** (Mac computers) from the menu bar.
   
   The *SMART Response Preferences* dialog box appears.

3. Click the **Networking** tab.

4. Clear the **Randomize** check boxes beside the *Encrypted data channel* and *File data channel* boxes if they’re selected, and then type the port numbers you want to use.

5. Click **OK**.

**To use random service ports**
1. Start **Teacher Tools**. See *Starting Teacher Tools* on page 25
   
   *Teacher Tools* appears.

2. Select **Edit > Preferences** (Windows computers) or **Teacher Tools > Preferences** (Mac computers) from the menu bar.
   
   The *SMART Response Preferences* dialog box appears.

3. Click the **Networking** tab.

4. Select the **Randomize** check box beside the *Encrypted data channel* or *File data channel* boxes.

5. Click **OK**.
Creating a class list

Before you can start a class in Sign In mode, you must have a class list. You can use Teacher Tools to create a list, or you can import one from a Microsoft Excel® or comma separated values (CSV) file.

NOTE
You don't need to create a class list if you're starting the class in Anonymous mode. For more information, see About Sign In and Anonymous modes on page 67.

Creating a class list in Teacher Tools

To create a class list


2. Click Add a Class in the Gradebook area on the left.

3. Type a name for your class (for example, Math), add any optional details in the Class Information boxes, and then click Add.

After a short delay, the new class’s window appears and the class name appears in the Gradebook area.

4. Click the Students tab at the top of the window.

5. Click Add on the toolbar.

The Properties window appears below the table.

6. If you are using SMART Response LE clickers, type a unique number between 1 and 199 in the Clicker ID box.

NOTE
The clicker IDs in the class list must correspond with the IDs programmed into the student clickers.

7. Type a unique 1 to 15 digit ID in the Student ID box.
8. Type a student’s name in the Name boxes. The student’s e-mail address and tags are optional. You can also type name and ID information directly in the table.

**NOTE**

You can use tags to categorize the students in custom groupings that SMART Response software uses when you create student reports.

The student information saves to the class list as you type it.

9. Repeat these steps for each student.

**Importing a class list from Excel®**

**IMPORTANT**

This feature is supported by SMART Response software for Windows operating systems only.

If you use Microsoft Excel to maintain class lists, you can import an .xls or .xlsx file into Teacher Tools to create a SMART Response class list. You might find it easier to copy the list of names in your current Excel document into a new spreadsheet.

**Creating class lists for all modes except LE**

Use the following procedure to create class lists for classes that don’t use LE clickers.

**To create a class list in an Excel spreadsheet**

1. Open the Excel spreadsheet that contains your students’ names.
2. Insert a blank row at the top of the spreadsheet if it doesn’t already have one.
3. Type **ID Number** in the first cell (A1).
4. Type **First Name** in the first cell of the second column (B1).
5. Type **Last Name** in the first cell of the third column (C1).
6. Move the first and last names into the columns directly below the headings.
7. In column A, type a unique 1 to 15 digit ID number for each student.

**EXAMPLE**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID Number</td>
<td>First Name</td>
</tr>
<tr>
<td>2</td>
<td>1234</td>
<td>David</td>
</tr>
<tr>
<td>3</td>
<td>6789</td>
<td>Jane</td>
</tr>
<tr>
<td>4</td>
<td>5678</td>
<td>John</td>
</tr>
<tr>
<td>5</td>
<td>3456</td>
<td>Mary</td>
</tr>
</tbody>
</table>

8. Save the spreadsheet.

**Creating class lists for LE mode**

Use the following procedure to create class lists for classes that use LE clickers.

- **To create a class list in an Excel spreadsheet**
  1. Open the Excel spreadsheet that contains your students’ names.
  2. Insert a blank row at the top of the spreadsheet if it doesn’t already have one.
  3. Type **ID Number** in the first cell (A1).
  4. Type **Clicker ID** in the first cell of the second column (B1).
  5. Type **First Name** in the first cell of the third column (C1).
  6. Type **Last Name** in the first cell of the fourth column (D1).
  7. Move the first and last names into the columns directly below the headings.
  8. In column A, type a unique 1 to 15 digit ID number for each student.
9. In column B, type a unique clicker ID from 1 to 199 for each student’s clicker.

**Example**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID Number</td>
<td>Clicker ID</td>
<td>First Name</td>
<td>Last name</td>
</tr>
<tr>
<td>2</td>
<td>12345</td>
<td>1</td>
<td>David</td>
<td>Jones</td>
</tr>
<tr>
<td>3</td>
<td>67890</td>
<td>2</td>
<td>Jane</td>
<td>Doe</td>
</tr>
<tr>
<td>4</td>
<td>56789</td>
<td>3</td>
<td>John</td>
<td>Swartz</td>
</tr>
<tr>
<td>5</td>
<td>34567</td>
<td>4</td>
<td>Mary</td>
<td>Smith</td>
</tr>
</tbody>
</table>

**Notes**

- The clicker ID must match the ID programmed into the student’s clicker. See **Assigning clicker IDs** on page 22.
- If you don’t include a **Clicker ID** column in the spreadsheet, SMART Response software will insert sequential Clicker IDs into the class list. You must then match the clicker IDs to the clickers either by editing the class list or by re-programming the clickers.

10. Save the spreadsheet.

**Importing the class list**

**To import a class list from an Excel spreadsheet**

1. Start **Teacher Tools**. See **Starting Teacher Tools** on page 25.

   *Teacher Tools* appears.

2. Click **Add a Class** in the **Gradebook** area on the left.

3. Type a name for your class, add any optional details to the **Class Information** boxes, and then click **Add**.

   After a short delay, the new class’s window appears, and the class name appears in the **Gradebook** area.

4. Click the **Students** tab at the top of the window.

5. Click the **Import** button at the top of the window, and then select **Students**.

   The **Import** dialog box appears.

6. Select the class you want to import the student list into, and then click **Next**.

7. Select **Microsoft Excel** from the **Import from** list, and then click **Next**.
8. Browse to and select the .xls or .xlsx file containing the class list, and then click **Open**.

After a short delay, the names and IDs from the spreadsheet appear in the **Students** page. You can now edit each student's properties, as required.

**Importing a class list from a CSV file**

If you use a database or spreadsheet program to maintain class lists, you may be able to export class lists as comma separated values (CSV) files. Refer to your database or spreadsheet program’s Help or user’s guide for more information.

**Creating class lists for all modes except LE**

Use the following procedure to create class lists for classes that don't use LE clickers.

- **To create a class list in CSV format**

  After exporting your class list as a CSV file, format your file in a text editor so that the first three values are **ID Number**, **First Name** and **Last Name** as shown below.

  **EXAMPLE**

  
<table>
<thead>
<tr>
<th>ID Number,First Name,Last Name,</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345,John,Doe,</td>
</tr>
<tr>
<td>54321,Jane,Doe,</td>
</tr>
<tr>
<td>56789,Bob,Jones,</td>
</tr>
<tr>
<td>98765,Barb,White</td>
</tr>
</tbody>
</table>

  For more information, see **CSV file formatting** on the next page.

- **Creating class lists for LE mode**

  Use the following procedure to create class lists for classes that use LE clickers.

  - **To create a class list in CSV format**

    After exporting your class list as a CSV file, format your file in a text editor so that the first four values are **ID Number**, **Clicker ID**, **First Name** and **Last Name** as shown below.

    **EXAMPLE**

    
    | ID Number,Clicker ID,First Name,Last Name, |
    |--------------------------------------------|
    | 12345,1,John,Doe,                          |
    | 54321,2,Jane,Doe,                          |
    | 56789,3,Bob,Jones,                         |
    | 98765,4,Barb,White                         |
For more information, see CSV file formatting below.

**To import a class list from a CSV file**

1. Start **Teacher Tools**. See *Starting Teacher Tools* on page 25.
   
   *Teacher Tools* appears.

2. Click **Add a Class** in the Gradebook area on the left.

3. Type a name for your class, add any optional details to the Class Information boxes, and then click **Add**.
   
   After a short delay, the new class’s window appears, and the class name appears in the Gradebook area.

4. Click the **Students** tab at the top of the window.

5. Click the **Import** button at the top of the window, and then select **Students**.
   
   The **Import** dialog box appears.

6. Select the class you want to import the student list into, and then click **Next**.

7. Select **Comma Separated Values (CSV)** from the **Import from** list, and then click **Next**.

8. Browse to and select the CSV file containing the class list, and then click **Open**.
   
   After a short delay, the names and IDs from your CSV file appear in the Students page. You can now edit each student’s properties, as required.

---

**CSV file formatting**

**Tips for formatting CSV files for importing class lists**

The following is the general format you should use for CSV files:

The order of the columns isn’t important, but the first row must contain the column headings identifying what’s in each column.

- You must have a column with the heading **ID Number**.
  
  ○ You must put a single space between **ID** and **Number**.
  
  ○ In place of ID Number, you can use **ID**, **Student ID** or **Number**.
  
  ○ If you don’t use a correct column name for the **ID Number**, the software is unable to import the list.
- Specify student first and last names in separate columns.
  - For the student's given name, use **First Name** for the column heading.
  - For the student's family name, use **Last Name** for the column heading.
  - You must put a single space between **First** (or **Last**) and **Name**.
  - In place of **First Name**, you can use **Given Name**.
  - In place of **Last Name** you can use **Last, Family Name** or **Surname**.

- You can also use the heading **Full Name** to import a single value that combines the first and last names.
  - You must put a single space between **Full** and **Name**.
  - In place of **Full Name**, you can use **Full** or **Name**.
  - If you use **Full Name**, the software checks to see whether the first and last names are separated by a comma (Last, First). If there isn't a comma, it separates the names with a space (First Last).
  - If you put three or more names with spaces between them, the software uses the last word as the last name and joins all of the first words to form the first name. For example, "Michael John Smith" is split with the last name as Smith, and the first name as Michael John.

**NOTE**

If your spreadsheet or database software automatically inserts quotation marks around the comma separated values, the software ignores them and the import works properly.

### Using SMART Sync Class List Server class lists

When you use SMART Response software in CE mode, you can use class list information from a SMART Sync Class List Server instead of using a class list you created using Teacher Tools. Teachers using SMART Sync can create class list information and store it on their SMART Sync Class List Server. When you start SMART Response Teacher Tools, you can then select which teacher's class information to use for your class.

Alternatively, teachers using SMART Sync software can start a SMART Response class using their class information.
Editing a class list

After you create a class list, you can use Teacher Tools to edit it.

**NOTES**

- You’re unable to edit a class list or remove students from it if a class is running. However, you can add students and import class lists after a class has started.
- When you use SMART Response in CE mode while connected to a SMART Sync Class List Server, you can’t make changes to the class list information stored on the server.

Editing student information

**NOTE**

You’re unable to edit student information if a class is running.

To edit student information

2. Select the class from the Gradebook area on the left.
3. Click the Students tab.
   The class list appears.
4. Select the student whose information you want to edit.
   The Properties tab appears below the class list.
5. Type the changes into the Properties boxes.
6. Repeat steps 4 and 5 for each student.

Adding students to a class list

To add a student to a class list

2. Select the class from the Gradebook area on the left.
3. Click the **Students** tab.

   The class list appears.

4. Click **Add** on the toolbar.

   The **Properties** tab appears below the class list.

5. Type a unique number of 1 to 15 digits in the **Student ID** box.

   ![NOTES]
   
   - If you are using SMART Response in CE mode, you can use up to 40 alphanumerical characters in the **Student ID** box.
   
   - Students with alphanumerical IDs or IDs of more than 15 characters cannot sign in using a clicker or Internet-enabled devices (VE mode).

   The student information saves to the class list as you type it.

6. Type a student’s name in the **Name** boxes. The student’s e-mail address and tags are optional. You can also type name and ID information directly in the table.

   ![TIP]
   
   You can use tags to categorize the students in custom groupings that SMART Response software uses when you create student reports. See **Tagging students** on the next page.

7. Repeat steps 4 to 6 for each student.

### Removing students from a class list

![NOTE]

You're unable to remove students from a class list if a class is running.

---

**To remove a student from a class list**

1. Start **Teacher Tools**. See **Starting Teacher Tools** on page 25.

   **Teacher Tools** appears.

2. Select the class from the **Gradebook** area on the left.

3. Click the **Students** tab.

   The class list appears.

4. Select the student you want to remove, and then click **Delete** on the toolbar.
A message appears asking you to confirm the deletion.

5. Click Yes.

**Tagging students**
You can use tags to identify groups or categories of students. SMART Response software uses the tags to sort student results when you generate class performance reports. For example, if you assign the tags “Senior” and “Junior” to the students, SMART Response software adds a chart to the report, with one bar for each of the two tags.

You can assign multiple tags to a student by separating the tags with a semicolon (;), for example “Senior;Honors” and “Junior;Honors”. In this case, SMART Response software adds a chart to the report, with three bars (one each for “Senior”, “Junior” and “Honors”).

You can also create tag subcategories by separating the tags with a colon (:). An example would be “Gender:Male” and “Gender:Female”. In this case, SMART Response software generates a single report section for “Gender” showing data grouped in “Male” and “Female” subcategories.

**Changing a class’s passing grade**
When you create a class list, you define the passing grade for the class. You can change that grade later if you want.

To change a class’s passing grade

1. Start **Teacher Tools**. See **Starting Teacher Tools** on page 25.

   *Teacher Tools* appears.

2. Select the class from the **Gradebook** area on the left.

3. Click **Edit** beside the class name.

   The *Edit Class Information* window appears.

4. Edit the **Passing Grade** value, and then click **Done**.
Chapter 3
Using SMART Response software

About SMART Notebook software ......................................................... 42
  SMART Notebook with SMART Response software ................................ 42
  Setting SMART Response preferences in SMART Notebook software ................ 42
Creating assessments .............................................................................. 44
  Creating an assessment .......................................................................... 44
  Adding content pages to the assessment ................................................. 45
  Defining feedback options ..................................................................... 46
Adding questions to the assessment .......................................................... 47
  About question types ............................................................................. 47
  About intelligent expression grading ..................................................... 49
  Creating answer keys ............................................................................ 51
Adding questions using the Insert Question wizard ...................................... 52
  Assigning tags to new questions ............................................................ 54
  Creating custom tags ............................................................................ 54
Importing questions from a Word document ............................................... 55
  Example Word document question formats .......................................... 56
Importing questions from an XML or SQZ file ............................................. 57
Importing questions from a PDF file ........................................................ 58
  PDF document formatting ...................................................................... 59
Importing questions from ExamView HTML ............................................... 60
  About ExamView HTML question importing .......................................... 61
  Exporting ExamView tests ...................................................................... 62
Setting answers for imported questions ..................................................... 63
  Adding choices to a question ................................................................. 63
Tagging questions ..................................................................................... 64
  Assigning tags to questions ................................................................... 64
About SMART Notebook software

Use SMART Notebook collaborative learning software to save notes written on a SMART interactive product or at your computer as a series of pages. You can use SMART Notebook software to create a presentation full of colorful clip art, graphics, text and Adobe Flash Player compatible files. Then you can present that SMART Notebook file, keeping your audience’s attention as you move and interact with these objects. When your audience provides comments and suggestions, write their input on a page using the pen tray tools or the pen buttons in SMART Notebook software.

Because SMART Notebook software works on many platforms, you can share files created on a Windows computer with people who use a Mac computer. You can also export your SMART Notebook file as a cross-platform HTML or PDF file, or as a series of image files.

SMART Notebook with SMART Response software

The integration of SMART Response software with SMART Notebook software means that you can create question sets, import questions from Microsoft Word or XML files and start and stop question sessions directly from SMART Notebook software. You can export the class’s and individual students’ results to a Microsoft Excel file or an HTML page. Using SMART Response software’s printing feature, create handout materials, copies of the questions and graded results pages for each student and for the class. This section introduces the SMART Response software features in SMART Notebook software. For more information about using other SMART Notebook features, refer to SMART Notebook’s online Help or the SMART website.

Setting SMART Response preferences in SMART Notebook software

You can customize the default behavior of some of SMART Notebook software’s SMART Response features.

To define how SMART Response software inserts instant questions

1. Select Response > Preferences from the SMART Notebook menu bar.

2. If you want the Insert Question button to insert the question on a SMART Notebook page that already has notes or images on it, select Insert on the current page when possible.

   If you want to create a new page containing your question, select Always insert on a new page.

   If you want SMART Response software to ask you each time, select Always ask before inserting (default setting).
To define the Response tab options

1. Select **Response > Preferences** from the **SMART Notebook** menu bar.

2. Select **Pie Chart** or **Bar Chart** in the **Default chart type for tab results** drop-down list to define the type of results chart you want to display by default.

3. If you want to display the **Response** tab immediately after you start an assessment so you can immediately monitor the progress of the assessment, select **Show the Response tab when you start an assessment**.

   If you want to display the **Response** tab immediately after you stop an assessment so you can immediately display the assessment results, select **Show the Response tab when you stop an assessment**.
Creating assessments

You can use SMART Notebook software to create assessments.

Creating an assessment

By creating assessments, you can collect results for each question and for the entire assessment at the same time. You can define feedback options that show whether students answered correctly, what the correct answer was and how the class performed on the question or the entire assessment.

You can install SMART Response software on any computer to create question sets that you can later copy to and run on the computer system in your classroom.

**NOTE**

You’re unable to run assessment files on a computer with standard SMART Notebook software installed. You must have SMART Notebook software that includes SMART Response software.

To create an assessment

1. Click the **SMART Response** icon in the Windows notification area or Mac menu bar, and then select **Open Notebook Software**.
   
   A blank SMART Notebook page appears.

2. Click the **Response** tab.

   **TIP**

   On Windows computers, you can clear the **Auto-hide** option to keep the options visible while you work on your assessment.

3. Click **Title Page**.
   
   The *Insert Title Page* dialog box appears.

4. In the top text box, type a title for your assessment.

5. Select the type of assessment you want to create, and then click **Add**. Optionally, you can type Subject and Topic information.

   Title page information appears on the SMART Notebook page, and the *Response* tab displays several options that enable you to customize your assessment.
To edit the assessment title page and description

1. On the SMART Notebook page, double-click the title, grade, subject or date text to change its properties or edit the text.
2. Click the Response tab.
3. In the Description area, edit the options you defined when you created the assessment.

**NOTE**

If you edit the SMART Notebook page, the Description information doesn't change. Similarly, if you edit the Description information, the SMART Notebook page doesn't change.

To add question and content pages to your assessment

See Adding questions to the assessment on page 47 and Adding content pages to the assessment below.

To save your assessment

1. Click Save.
   
   A Save As dialog box appears.
2. Browse to a folder, type a file name, and then click Save.

Adding content pages to the assessment

You can add content pages anywhere in your assessment to introduce questions or provide background information.

To add a content page

1. Create your assessment. See Creating an assessment on the previous page for more information.
2. Click the Page Sorter tab, and then select the page you want to insert a content page after.
3. Click the Response tab.
4. Click the Next Steps tab.
5. Click Make the next page a content page.

A blank page appears.
6. Use SMART Notebook’s tools to add text, images or Adobe Flash Player compatible files from the Gallery.

### Defining feedback options

Feedback options allow you to show your students their individual grades, the correct answers and the class average.

#### NOTE

The feedback options available vary depending on the SMART Response mode.

<table>
<thead>
<tr>
<th>Feedback option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After you stop collecting responses</td>
<td>The students can see how they answered and see their grades after you click <strong>Stop</strong>. If you select this option, you can also choose to show the correct answers with grades and show class average.</td>
</tr>
<tr>
<td>After all questions are answered</td>
<td>The students can see how they answered and see their grades after they finish answering all questions. If you select this option, you can also choose to show the correct answers with grades and show class average.</td>
</tr>
<tr>
<td>After each question is answered</td>
<td>The students can see how they answered each question and see their grades after they finish answering all questions. If you select this option, you can also choose to show the correct answers with grades and show class average.</td>
</tr>
<tr>
<td>Don’t show students their grades</td>
<td>The students can’t see how they answered or their grades.</td>
</tr>
<tr>
<td>Don’t allow students to save assessment</td>
<td>Students using SMART Notebook SE software can’t save the assessment to their binders after they finish.</td>
</tr>
</tbody>
</table>

### To define feedback options

1. Create your assessment. See *Creating an assessment* on page 44 for more information.

2. On the **Response** tab for the assessment’s title page, select one of the options described in the previous table from the **Show results to students** drop-down list.
Adding questions to the assessment
SMART Response supports up to seven question types depending on the device students use to answer questions.

You can add questions to the assessment using the Insert Question wizard or by importing questions from a Microsoft Word document, XML file, SQZ file, PDF file (Mac only) or ExamView® HTML file.

After you create a question, you can add choices to it or tag it.

About question types
Using SMART Response software, you can ask the following types of questions either individually or as question sets. You can also add notes to any question type that appears when you print the question results.

**NOTES**
- Opinion questions don’t have a correct answer and aren’t worth points.
- If you include a question of a type that isn’t supported in the SMART Response mode you’re using, the question appears with an *Unsupported Question Type* icon in the *Page Sorter* tab in SMART Notebook software.

<table>
<thead>
<tr>
<th>Question type</th>
<th>Description</th>
<th>Students can answer with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes or no</td>
<td>Students use the Y (green on LE clickers) or N (red on LE clickers) button to answer a question. You can also choose the Opinion option to allow either answer.</td>
<td>Std. PE LE NBSE XE VE Multi</td>
</tr>
<tr>
<td>True or false</td>
<td>Students use the True (green on LE clickers) or False (red on LE clickers) button to answer a question. You can also choose the Opinion option to allow either answer.</td>
<td>Std. PE LE NBSE XE VE Multi</td>
</tr>
</tbody>
</table>
### Question Type | Description | Students can answer with
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple choice</strong></td>
<td>Students use a single button, A through J, to answer the question. Select from 2 to 10 answers (2 to 5 answers for LE clickers) for a question. You can also choose the Opinion option to allow any answer.</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td><strong>Multiple answer</strong></td>
<td>Students use the A through J buttons to select the correct combination of answers to the question. Select from 2 to 10 answers for the question. You can also choose the Opinion option to allow any combination of answers.</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td><strong>Number, fraction or decimal</strong></td>
<td>Students use the number buttons to answer questions with numeric answers using whole numbers, fractions or decimals. You can also choose the Opinion option to allow any answer.</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
</tr>
<tr>
<td><strong>Text answer</strong></td>
<td>Students type the answer to the question. There is a 20-character limit on answers to text answer questions. You can also choose the Opinion option to allow any answer. Students using XE clickers or Internet-enabled devices (in VE mode) can type up to 140 characters when answering Opinion questions.</td>
<td>✓ ✓ ✓ ✓ ✓ See Note</td>
</tr>
<tr>
<td><strong>Number, fraction or expression</strong></td>
<td>Students use math symbols and numeric values to answer the question. There is a 30-character limit on expression answers.</td>
<td>✓</td>
</tr>
</tbody>
</table>

---

**NOTE**

Text answers aren’t supported in Multiple SMART Response devices mode if you select the I have students using SMART Response / Senteo or SMART Response LE option. See Selecting how students answer questions on page 18.
About intelligent expression grading

When you create an expression question and correct answer, intelligent expression grading accepts multiple representations of that answer expression as correct.

A student’s answer is always graded correct if it:

- matches the question’s correct answer exactly.
- has a different representation, but is mathematically equivalent and uses the same terms and operators in the same order as the question’s correct answer.

You can use intelligent grading options to decide which other mathematically equivalent answers to accept as correct. The following graphic shows the three levels of equivalency that you can define for your questions.

![Equivalency Levels Graphic]

The following table shows examples of how SMART Response software's intelligent expression grading compares expression answers to the question's correct expression answer.

<table>
<thead>
<tr>
<th>Teacher's correct answer</th>
<th>$3x$</th>
<th>$\frac{x-1}{3}$</th>
<th>$x^2$</th>
<th>$\sqrt{x}$</th>
<th>$3.0 \times 10^3$</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exact match</strong></td>
<td>$3(x)$</td>
<td>$(x - 1)/3$</td>
<td></td>
<td></td>
<td>$3.0 \times 10^4$</td>
</tr>
<tr>
<td></td>
<td>$3 \times x$</td>
<td>$(x - 1) - 3$</td>
<td></td>
<td></td>
<td>($3.0)(10^2)$</td>
</tr>
<tr>
<td></td>
<td>$3 \times x$</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Formal equivalent</strong></td>
<td>$x^3$</td>
<td>$\frac{-1 + x}{3}$</td>
<td></td>
<td></td>
<td>$3.0 \times 10^3$</td>
</tr>
<tr>
<td></td>
<td>$x \times 3$</td>
<td>$(1-x)/3$</td>
<td></td>
<td></td>
<td>$3.0 \times 10^2$</td>
</tr>
<tr>
<td></td>
<td>$x \times 3$</td>
<td></td>
<td></td>
<td></td>
<td>$3.0 \times 10^2$</td>
</tr>
<tr>
<td><strong>Content equivalent</strong></td>
<td>$(-3)(-x)$</td>
<td>$\frac{x - 1}{3}$</td>
<td></td>
<td>$x \times x$</td>
<td>$3.0 \times 10 \times 10$</td>
</tr>
<tr>
<td></td>
<td>$3x + 1 - 1$</td>
<td>$\frac{x}{3}$</td>
<td></td>
<td>$x^{65}$</td>
<td>$300$</td>
</tr>
<tr>
<td></td>
<td>$3x$</td>
<td></td>
<td></td>
<td>$x^{\frac{1}{2}}$</td>
<td></td>
</tr>
</tbody>
</table>
The following table shows examples of how student answers would be graded depending on which equivalency option you chose.

<table>
<thead>
<tr>
<th>Teacher's correct answer</th>
<th>Student's answer</th>
<th>Exact match</th>
<th>Formal equivalent</th>
<th>Content equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>((x - 1)(x + 3))</td>
<td>((x - 1) \times (x + 3))</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>((x - 1) \times (x + 3))</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>((x + 3)(x - 1))</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>((x - 1)(3 + x))</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(x^2 + 2x - 3)</td>
<td>×</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(5.0 \times 10^2)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(5.00 \times 10^2)</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(5 \times 10^2)</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(0.5 \times 10^3)</td>
<td>×</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(500)</td>
<td>×</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(-b \pm \sqrt{b^2 - 4ac})/(2a)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>((-b \pm \sqrt{b^2 - 4ac}) - (2a))</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(-b \pm \sqrt{b^2 - 4ac} + \frac{b^2}{2a})</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(\pm \sqrt{-4ac + b^2 - b})/(2a)</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>(-b \pm \sqrt{\frac{b^2 - 4ac}{2a}})</td>
<td>×</td>
<td>×</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
Creating answer keys

If you already have a quiz or assessment in another format, such as in a hardcopy format, or in a multimedia file, you can create an answer key for that assessment to record the assessment’s progress and student’s grades. You can then use SMART Response tools to generate, export and print assessment and student reports.

When you create an answer key you create a SMART Notebook file containing a series of SMART Response question pages showing possible answers to your assessment questions but without question content. When you start your assessment, students can use SMART Response devices to answer the questions at their own pace.

**NOTE**
The question options available when you create your answer key change depending on SMART Response operating mode you are using. See Selecting how students answer questions on page 18.

To create an answer key

1. Click Response > Create Answer Key.

   The Create Answer Key dialog box appears.

2. Type a title in the Title box.

3. Select an option from the Type drop down list.

4. Select the thumbnail for the type of question you want.

   The correct answer options available depend on the question type you select.

5. Select or type the correct answer, or the Opinion option for this question.

6. Adjust the points value and create tags for this question, if required.

7. If you selected Multiple answer, Text or Number, fraction, expression questions in step 4, click Add.

   The Questions table updates showing your selection.

8. Repeat steps 4 through 7 for each question.

9. Click Create.

   SMART Notebook software adds pages for each question, preceded by a title page.

10. Click File > Save As, type a file name, and then click Save.
You can now start the assessment, and ask the students to respond to the questions. Refer to *Starting and connecting to a class* on page 65 for information. You can edit your answer key using the same procedures found in *Adding questions to the assessment* on page 47.

### Adding questions using the Insert Question wizard

With SMART Notebook software, you can ask your students questions and collect their answers. Using the *Insert Question* wizard, you can select tags from a comprehensive list of Educational Standards and Cognitive Level tags for the questions you create in SMART Notebook software or you can create custom tags. You can also add or change the tags to questions after you finish creating an assessment. See *Tagging questions* on page 64.

#### To add a question using the Insert Question wizard

1. Click the **SMART Response** icon in the Windows notification area or Mac menu bar, and then select **Open Notebook Software**.
   
   A blank SMART Notebook page appears.

2. Click **Insert Question** on the toolbar.
   
   The *Insert Question* wizard appears.

3. Click the thumbnail of the question type you want to add, and then click **Next**.

4. Type the question in the text box.

5. If you want to use tags to create categories in your reports, go to the *Assigning tags to new questions* on page 54.

6. Click **Next**.
7. For yes or no and true or false questions, select the correct answer or the Opinion option.

For number, fraction or decimal questions, type the correct answer or select the Opinion option.

For multiple choice or multiple answer questions, select the number of answers, type the answers in the text boxes, click Next, and then select the correct answers or the Opinion option.

For text answer questions, type one to four acceptable answers or select the Opinion option. See Note 1 below.

For number, fraction or expression questions, use the expression editor to create the expression question, and then use the editor to create a correct expression answer. See Note 2 below.

8. Type the number of points the student receives for a correct answer.

   ✋ TIP

   The value can be a whole or decimal number.

9. If you want to create more questions, click Insert Another, and then repeat steps 2 to 7.

10. Click Finish.

11. Optionally, use SMART Notebook’s tools to add images or Adobe Flash Player compatible files from the Gallery.

NOTES

1. Text answer questions are case-sensitive. You can enter up to four answers to support different capitalizations (for example, "iron", "Iron" and "IRON").

2. SMART Response XE software’s intelligent expression grading feature compares the student responses to the correct expression answer to determine whether it is equivalent based on the Intelligent Grading settings you define. See About intelligent expression grading on page 49 for more information.
Assigning tags to new questions

To assign tags to new questions

1. Complete the first five steps of the Adding questions using the Insert Question wizard on page 52.

2. Click Browse.

3. If you want to choose from a large selection of Educational Standards or Cognitive Level tags, select your region, grade and subject, and then select one or more tags from the categories listed.
   - If you want to select your custom tags, select one or more tags below the Custom Tags category.
   - If you want to create custom tags see the Creating custom tags below.
   - The selected tags appear in the Tags for this question field.

4. Click Finish.

5. Go back to step 6 of the Adding questions using the Insert Question wizard on page 52.

Creating custom tags

You can use custom tags to identify your own groups or categories of questions. SMART Response software uses the tags to sort responses to questions when you generate Student Performance and Class Performance reports.

For example, if you assign the tags "Difficult" and "Easy" to questions, SMART Response software creates a chart in the report for questions with "Difficult" and "Easy" tags.

To create custom tags

1. Right-click Custom Tags, select Create Custom Tag, and then edit the New Tag label.
   - The new tag appears below Custom Tags.

2. Repeat to create all the custom tags you need for your assessment, and then click Finish.
Importing questions from a Word document

**IMPORTANT**
This feature is supported on SMART Response software for Windows computers only.

When you import questions from a Microsoft Word document, SMART Response software’s conversion utility uses a variety of techniques to identify which paragraphs are questions, which paragraphs are possible answers and what type of question to create from the given information. Its most basic technique is to interpret the numbering of the paragraphs. The software also searches for key words when parsing the paragraphs. The software then converts the paragraphs into SMART Notebook assessment pages. See Example Word document question formats on the next page for more information.

**NOTE**
SMART Response software is unable to provide the correct answers to imported questions.

To import questions from a Word document

1. Click the SMART Response icon in the Windows notification area, and then select Open Notebook Software.
   
   A blank SMART Notebook page appears.

2. Select Response > Import Question From > Microsoft Word.
   
   The Open dialog box appears.

3. Browse to and select the Word document, and then click Open.
   
   A progress bar appears and closes when the conversion is complete.

4. In the Page Sorter tab, select the thumbnail for the title page.

5. Optionally, edit and customize the title page and description.

6. In the Page Sorter tab, select the thumbnail for the first question page and check it carefully to verify that the conversion process was successful.

7. Repeat step 6 for all questions in the assessment.

After you import the questions, see Setting answers for imported questions on page 63.
Example Word document question formats

The following list of questions is an example of how to format your Word document before you import it into SMART Response software.

**NOTE**
Some SMART Response modes don't support all of the following example question types. See Selecting how students answer questions on page 18 for more information.

1. According to the U.S. Census Bureau, the majority of poor children live in:
   a. urban areas
   b. suburban areas
   c. rural areas

2. Can you fill a 10 L aquarium with five 2 L pitchers of water?
   Yes
   No

3. True or false: Half of all even whole numbers are divisible by 4.
   True
   False

4. Let \( x = 3 \). Compute \( y \) from the equation below.
   \[ y = 20 - 4x \]
   Answer: ______________________

5. Which Native American group lived in the highlighted area on the map?
   a. Kwakiutl
   b. Sioux
   c. Iroquois

**NOTE**
Ensure that you format the questions in your Word document like the ones in these examples before you import the file. In most cases, the import utility ignores headers and footers in the Word document.
Importing questions from an XML or SQZ file

SMART Response software includes an import feature for converting questions from ExamView format XML files or SMART Sync software SQZ files into question sets. SMART Response software uses the tags in the XML and SQZ files to extract questions, answers and correct responses, and then converts the information into assessment pages.

**IMPORTANT**

You must have or create an ExamView formatted XML text file or a SMART Sync software SQZ file before you can perform this procedure. Binary ExamView formatted files are not supported.

To import questions from an XML or SQZ file

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Open Notebook Software.
   
   A blank SMART Notebook page appears.

2. Select Response > Import Question From > XML.

   The Open dialog box appears.

3. Browse to and select an XML or SQZ file, and then click Open.

   A progress bar appears, followed by the title page for the new question set.

4. In the Page Sorter tab, select the thumbnail for the first question page.

5. Add a title page to the assessment, and then customize the page and description as desired.

6. Edit and customize the first question page as desired.

   Check the question carefully, including the correct answer (see below), to verify that the conversion process was successful.

7. Repeat step 6 for all questions in the set.

8. Click Save.

   A Save As dialog box appears.

9. Browse to a folder, type a name for the file, and then click Save.

After you import the questions, see Setting answers for imported questions on page 63.
Importing questions from a PDF file

**IMPORTANT**
This feature is available only with SMART Response for Mac computers.

When you import questions from a PDF file, the SMART Response conversion utility interprets the numbering of the paragraphs. The software also recognizes key words when parsing the paragraphs. The software then converts the paragraphs into SMART Notebook assessment pages.

**IMPORTANT**
Ensure that you format the questions in your PDF file like the ones in *PDF document formatting* on the next page before you begin this procedure.

To import questions from a PDF file

1. Click the **SMART Response** icon in the Mac menu bar, and then select **Open Notebook Software**.
   A blank SMART Notebook page appears.
2. Select **Response > Import Question From > PDF File**.
   The **Open** dialog box appears.
3. Browse to and select the PDF file, and then click **Open**.
   A progress bar appears and closes when the conversion is complete.
4. In the **Page Sorter** tab, select the thumbnail of the title page.
5. Edit and customize the title page and description.
6. Edit and customize the first question page.
7. Check the question carefully to verify that the conversion process was successful.
8. Repeat steps 6 and 7 for all questions in the assessment.

After you import the questions, see *Setting answers for imported questions* on page 63
PDF document formatting

The text below shows examples of multiple choice questions formatted so that SMART Response software can easily convert them to question pages.

1. How is the boy involved in the dog’s care?
   a. He feeds the dog twice a day.
   b. He walks the dog once a day.
   c. He cleans up the dog’s messes.
   d. He gives the dog a lot of affection.

2. What percentage of the U.S. Government budget goes to welfare and Social Security?
   a. 25% to welfare and 25% to Social Security
   b. less than 1% to welfare and 20% to Social Security
   c. 20% to welfare and 1% to Social Security
   d. less than 1% to welfare and less than 1% to Social Security

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You can import only multiple choice questions.</td>
</tr>
<tr>
<td>• Remove headers and footers from your PDF file because the import utility will attempt to convert them into questions.</td>
</tr>
<tr>
<td>• Introduction, background or source information not related to questions should be on separate pages.</td>
</tr>
<tr>
<td>• Text and graphics that the import utility can't convert into questions are imported to a SMART Notebook page as a graphic.</td>
</tr>
</tbody>
</table>
Importing questions from ExamView HTML

You can import ExamView 5.2.0 and 6.2.1 HTML question files into a SMART Response assessment. See Exporting ExamView tests on page 62 for information about exporting HTML question files from ExamView.

**NOTE**

SMART Response is unable to identify the correct answers to imported questions. You must set the correct answers after you import the questions. See Setting answers for imported questions on page 63.

To import questions from an ExamView HTML file

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Open Notebook Software.
   
   A blank SMART Notebook page appears.

2. Select Response > Import Question From > ExamView HTML.
   
   The Open dialog box appears.

3. Browse to and select the HTML file, and then click Open.

   A progress bar appears and closes when the conversion is complete.

4. In the Page Sorter tab, select the thumbnail for the title page.

5. Optionally, edit and customize the title page and description.

6. In the Page Sorter tab, select the thumbnail for the first question page and check it carefully to verify that the conversion process was successful.

   See About ExamView HTML question importing on the next page for information about how ExamView questions are converted to SMART Response questions.

7. Repeat step 6 for all questions in the assessment.

After you import the questions, see Setting answers for imported questions on page 63.
About ExamView HTML question importing

The following table shows how SMART Response software imports ExamView HTML question files.

<table>
<thead>
<tr>
<th>This ExamView question type</th>
<th>Imports as this SMART Response question type</th>
</tr>
</thead>
<tbody>
<tr>
<td>True or false</td>
<td>True or false</td>
</tr>
<tr>
<td>Modified true or false</td>
<td>True or false</td>
</tr>
<tr>
<td>This is a two-part question: if the answer is false, the student modifies the question to make it true.</td>
<td></td>
</tr>
<tr>
<td>Multiple choice</td>
<td>Multiple choice</td>
</tr>
<tr>
<td>Choice labels import in uppercase letters. Custom choice labels don't import.</td>
<td></td>
</tr>
<tr>
<td>Multiple answer</td>
<td>Multiple answer</td>
</tr>
<tr>
<td>Choice labels import in uppercase letters. Custom choice labels don't import.</td>
<td></td>
</tr>
<tr>
<td>Yes or no</td>
<td>Yes or no</td>
</tr>
<tr>
<td>Numeric response</td>
<td>If the original answer is a decimal or fraction value, it imports as a Numeric, decimal, fraction question. If the original answer is a math expression, it imports as an Opinion Numeric, fraction, expression question.</td>
</tr>
<tr>
<td>Short answer or text answer</td>
<td>Text answer</td>
</tr>
<tr>
<td>Only the first 20 characters of the answer import.</td>
<td></td>
</tr>
<tr>
<td>Matching</td>
<td>Content page</td>
</tr>
<tr>
<td>Problem</td>
<td>Text answer</td>
</tr>
<tr>
<td>Only the first 20 characters of the answer import.</td>
<td></td>
</tr>
<tr>
<td>Essay</td>
<td>Text answer</td>
</tr>
<tr>
<td>Only the first 20 characters of the answer import.</td>
<td></td>
</tr>
<tr>
<td>Case</td>
<td>Text answer</td>
</tr>
<tr>
<td>Only the first 20 characters of the answer import.</td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>Text answer</td>
</tr>
<tr>
<td>Only the first 20 characters of the answer import.</td>
<td></td>
</tr>
</tbody>
</table>
Exporting ExamView tests

You can export ExamView 5.2.0 and 6.2.1 online tests as HTML documents.

To export an HTML test document from ExamView 5.2.0

1. In ExamView Test Generator 5.2.0, select File > Publish Online Test.
   
   The Publish Online Test dialog box appears.

2. In Step 1, type a title for the assessment.

3. In Step 2, select the Save test as an HTML document to your hard drive option, and then click Next.

4. In Step 3, select the Publish a study guide option, and then click Next.

   **IMPORTANT**

   If you do not select the Publish a study guide option, you must manually add answer information to the questions.

   **TIP**

   You can also select the Show Rational, Show Feedback and Show Reference options. SMART Response converts any notes in the rational, feedback and reference boxes to SMART Notebook notes.

5. Type a file name for the HTML file, and then click OK.

   ExamView creates the HTML file and a _files folder containing all the image files used in the test.

To export an HTML test document from ExamView 6.2.1

1. In ExamView Test Generator 6.2.1, select File > Export to HTML.

   The Export to HTML dialog box appears.

2. Type a title for the assessment, select the Export as study guide option, and then click OK.

   **TIP**

   You can also select the Show Rational, Show Feedback and Show Reference options. SMART Response converts any notes in the rational, feedback and reference boxes to SMART Notebook notes.

3. Type a file name for the HTML file, and then click OK.

   ExamView creates the HTML file.
Setting answers for imported questions

After you import questions, you can set or change the answers to your assessment questions.

To set the answers for imported questions

1. In the Page Sorter tab, select the thumbnail for the first question page.

2. Select Response > Set All Answers.

   The Set All Answers dialog box appears.

3. Type or select the correct answers from the options for all questions, and then click Done.

4. Click Save.

   A Save As dialog box appears.

5. Browse to a folder, type a file name, and then click Save.

   You can run the question set on this computer or copy the SMART Notebook file to any computer that has SMART Response software installed.

Adding choices to a question

After you create a question, you can add choices to it.

To add a choice to a question

1. Click the Page Sorter tab.

2. Select the thumbnail of the question page you want to add a choice to.


4. Follow the on-screen instructions.

5. If you have to change the correct answer for the question, select Response > Set All Answers, and then make the changes.

NOTE

If you add choices to a true/false, yes/no, number/faction/decimal or text answer question, the question changes to multiple choice.
Tagging questions
You can select tags from a comprehensive list of educational standards and cognitive level tags for the questions you create in SMART Notebook software or you can create custom tags. See Adding questions using the Insert Question wizard on page 52. You can also add tags or change the tags to questions after you finish creating an assessment.

Assigning tags to questions

To add or change tags in existing questions

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Open Notebook Software.
   A blank SMART Notebook page appears.
2. Select File > Open, and then select your assessment file.
   The SMART Notebook file appears displaying the title page.
3. Select the thumbnail for the question page you want to add tags to.
   The question page appears.
4. Click the SMART Response tab, and then select the Properties tab.
5. If the Tags box isn't visible, click Show beside the Answer Key heading.
6. Click Browse.
7. If you want to choose from a large selection of educational standards or cognitive level tags, select your region, grade and subject, and then select one or more tags from the categories listed.
   If you want to select your custom tags, select one or more tags in the Custom Tags category.
   The selected tags appear in the Tags for this question field.
8. Click Finish.
9. Press Page Up or Page Down to select other questions as required, and then repeat steps 5 through 8.
10. Save your assessment.
To use SMART Response interactive response system in your classroom, you must start a class and allow students to connect to it. You can monitor the student connections during the class and disconnect them when the class is done.
Before class begins

Safety tips for teachers
When using SMART Response with a SMART Board interactive whiteboard and a projector:

- Tell students not to look directly at the light beam from the projector. Instead, encourage them to keep their back to the projector when working at the interactive whiteboard. Before they turn to face the class, they should take a big step (or two) sideways.

- Make sure you don't look directly into the light beam from the projector. Keep your back to the class when you write over a projected image. Step to the side of the interactive whiteboard before you turn to face the class.

- Tell your students not to touch the projector, because it can become extremely hot during normal operation.

- Don’t use a chair to increase a student's reach. If your students can’t reach the top of the interactive whiteboard, lower it. You may need to remount a wall-mounted unit to a lower position. If your interactive whiteboard is mounted on a floor stand, lower it with the help of another adult.

- Tell students not to run in the vicinity of the floor stand, because they could trip over the floor stand’s feet.
## Starting a class

You can start a class in Sign In mode or Anonymous mode.

### About Sign In and Anonymous modes

Before you start a class session, you must decide whether you want the system to operate in Sign In mode or Anonymous mode. This table summarizes the characteristics of each mode.

<table>
<thead>
<tr>
<th>Sign In mode</th>
<th>Anonymous mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teachers use a class list that identifies each student by name and ID number.</td>
<td>Teachers can operate the system without a class list.</td>
</tr>
<tr>
<td>Students can connect to the class, but they must sign in with their assigned ID numbers.</td>
<td>Students can connect to the class without identifying themselves.</td>
</tr>
<tr>
<td>Teachers can control when students can sign in by locking a class.</td>
<td>Teachers can't control when students using clickers can sign in to their class.</td>
</tr>
<tr>
<td>Under the teacher's control, students can see their own grades, but they can't see any other students' grades.</td>
<td>Under the teacher's control, students can see their own grades, but they can't see any other students' grades.</td>
</tr>
<tr>
<td>If the Remember names check box is selected, teachers can identify individual students as they connect to the class.</td>
<td>Teachers can see how many students are connected.</td>
</tr>
<tr>
<td>Teachers can use Gradebook to save and analyze student and class performance over time.</td>
<td>Teachers are unable to save and analyze student and class performance over time.</td>
</tr>
<tr>
<td>Teachers can generate student and class reports.</td>
<td>Teachers are unable to generate student or class performance reports.</td>
</tr>
<tr>
<td>Teachers can see, export and print the total class grade.</td>
<td>Teachers can see, export and print the total class grade.</td>
</tr>
<tr>
<td>Teachers can see, export and print total scores for each question.</td>
<td>Teachers can see, export and print total scores for each question.</td>
</tr>
<tr>
<td>Teachers can see, export and print each student's grade for each question and for the whole assessment.</td>
<td>Teachers are unable to identify student names or individual grades.</td>
</tr>
<tr>
<td>Teachers can review results during the assessment in the Response tab for the class as a whole and for individual students (if the Remember names check box is selected).</td>
<td>Teachers can view results for the class as a whole during the assessment in the Response tab.</td>
</tr>
</tbody>
</table>
Starting a class in Anonymous mode
You don't need a class list to operate SMART Response software in Anonymous mode. See About Sign In and Anonymous modes on the previous page for more information.

To start a class in Anonymous mode
In SMART Notebook software, select Response > Start Class, and then select Anonymous Mode.

- If students are using clickers, the receiver’s Ready light flashes and then turns solid green, and the receiver’s Transmit light flashes green.
- If SMART Response software is in CE mode, the name of the SMART Teacher file and class information appears in the student's SMART Notebook SE Quick Links tab.

You can now ask the students to connect.

NOTES

- You can start a class and the assessment at the same time in SMART Notebook software by selecting Response > Start Assessment.

  If you don't have a class list, the class starts in Anonymous mode. If you do have a class list, a No Classes Started dialog box appears where you can select Anonymous mode.

- You can also start a class in Teacher Tools.

- If the students are already signed in to a class using clickers or SMART Notebook SE software and you select Anonymous Mode, the software switches to Anonymous mode.

- If the students are connected in Anonymous mode and you start a class that requires sign-in, the students are signed off and then asked to sign in.
Starting a class in Sign In mode

When you use SMART Response software in Sign In mode, you can monitor each student’s responses and create reports on student and class performance. For more information, see About Sign In and Anonymous modes on page 67.

**NOTE**
Before you can start a class and have students connect in Sign In mode, you must have a class list. If you don't have a class list, you can create or import one. See Creating a class list on page 30.

**IMPORTANT**
Before you can use SMART Response LE software in LE mode, you must

- assign clicker IDs to each student’s clicker. See Pairing student clickers on page 21.
- create a class with a class list containing the clicker IDs. See Creating a class list in Teacher Tools on page 30.

**To start a class in Sign In mode**

In SMART Notebook software, select Response > Start Class, and then select a class name.

- If students are using clickers, the receiver’s Ready light flashes and then turns solid green, and the receiver’s Transmit light flashes green.
- If SMART Response software is in CE mode, the name of the SMART Teacher file and class information appears in the student’s SMART Notebook SE Quick Links tab.

You can now ask the students to connect.

**NOTES**

- You can start a class and the assessment at the same time in SMART Notebook software by selecting Response > Start Assessment.
- If you don't have a class list, the class starts in Anonymous mode. If you do have a class list, a No Classes Started dialog box appears where you can select a class.
- You can also start a class in Teacher Tools.
- If the students are connected in Anonymous mode and you start a class that requires sign-in, the students are signed off and then asked to sign in.
Monitoring clickers

You can use Teacher Tools to see if a clicker is logged on or if it’s in Anonymous mode. If the clicker is logged on, you can also see the student’s name. You can see each clicker’s hardware ID (MAC address) and identify which logged-on student is using it.

The display shows the signal strength of each clicker, as measured by the receiver. If the signal level is low for one or more clickers, and they are having communication problems, you can reposition the receiver or remove signal path obstructions.

To monitor clickers

1. Start a class and have your students connect their clickers.
   The SMART Response receiver indicator lights are green.

   Teacher Tools appears.

3. Click the Devices button in the left column.
   The Devices window appears with the message "Your SMART Response receiver is connected and working". The receiver name appears below the Devices button.

   **NOTE**
   If the "Your SMART Response receiver is not connected" message appears, the SMART Response receiver isn’t connected or isn’t working properly. Check the receiver connections or repeat the receiver installation.

4. Click My Receiver, and then click the Clickers tab at the top of the window.
   The Clickers window appears and displays a table of all connected clickers. Each row of the table shows one clicker’s signal strength, battery condition, student name and hardware ID (MAC address).

   **NOTE**
   If students’ clickers are connected anonymously, the Student Name field displays Anonymous.
Connecting to the class

After you start a class, you can tell your students to connect to the class.

How the students connect to the class depends on SMART Responses software's current mode. In addition, you can prevent students from signing in.

Connecting in Anonymous mode

You must start a class in Anonymous mode before your students connect. See Starting a class in Anonymous mode on page 68.

> IMPORTANT

In all modes except VE mode, students must know the class name.

To connect PE clickers in Anonymous mode

When the “SMART Response is ready to use” balloon message appears, tell your students to follow this procedure.

1. Press the clicker’s Power button for one second.

   A message appears asking if you want to join the last class the clicker was connected to or find a different class.

   Students using LE clickers see a “Hello” message on their clicker’s display.

2. Press the Enter button to join the last class.

   OR

   Press the Down button to select Find a class, and then press Enter.

   The clicker scans for classes, and then displays a list of classes within range. Press the Up and Down buttons to select the correct class, and then press Enter.

> NOTE

If you have multiple receivers connected to your computer, students see multiple class names that are numbered to identify each receiver. For example, Math(1 and Math(2.

Assign an equal number of students to each class to ensure optimum performance.

3. Press the Enter button to connect.
CHAPTER 4
Starting and connecting to a class

To connect XE clickers in Anonymous mode

When the “SMART Response is ready to use” balloon message appears, tell your students to follow this procedure.

1. Press the clicker’s Power button for one second.
2. Use the soft keys to join the last class.

OR

Use the soft keys to find a class, and then to select the class.

NOTE
If you have multiple receivers connected to your computer, students see multiple class names that are numbered to identify each receiver. For example, Math(1 and Math(2.

Assign an equal number of students to each class to ensure optimum performance.

To connect LE clickers in Anonymous mode

Tell the students to press their clicker’s Power button for one second.

A "Hello" message appears on the clicker display.

To connect Internet-enabled devices in Anonymous mode

When you start an assessment in VE mode, an Assessment Started message appears showing the SMART Response VE website URL and the Assessment ID. Record this information, and then tell your students to follow this procedure.

1. Open an Internet browser and connect to response.smarttech.com.
   The SMART Response VE login dialog box appears.
2. Type the Assessment ID into the appropriate text box, and then click Sign In.

NOTE
The Student ID isn't required in Anonymous mode.

The question appears on the students' screens.

To connect SMART Notebook SE users in Anonymous mode

Tell your students to follow the steps described in the SMART Notebook SE online Help system.
Connecting in Sign In mode
You must start a class in Sign In mode before your students connect. See Starting a class in Sign In mode on page 69.

IMPORTANT
When students use PE clickers, XE clickers or SMART Notebook SE software to connect to a class in Sign In mode, they must know the class name and a unique Student ID number.

When students use Internet-enabled devices (in VE mode), they must know the Assessment ID and a unique Student ID number.

After you start a class, tell your students to follow one of the procedures below.

To connect PE clickers in Sign In mode

1. Press the clicker’s Power button for one second.
   A message appears asking if you want to join the last class the clicker was connected to or find a different class.

2. Press the Enter button to join the last class.
   OR

   Press the Down button to select Find a class, and then press Enter.

   The clicker scans for classes, and then displays a list of classes within range. Press the Up and Down buttons to select the correct class, and then press Enter.

   NOTE
   If you have multiple receivers connected to your computer, students see multiple class names that are numbered to identify each receiver. For example, Math(1 and Math(2.

   Assign an equal number of students to each class to ensure optimum performance.

   A connecting message appears, followed by a message asking for an ID number.
3. Press the number buttons to enter your ID number, and then press Enter.

If the ID is valid, a message appears asking you to confirm your name.

**NOTE**

If the teacher selected the Lock Sign In option, a message appears on the clicker indicating that the student can't sign in at this time, and then a Retry option appears.

4. Press the Enter button to connect.

A welcome message appears.

---

**To connect XE clickers in Sign In mode**

1. Press the clicker's Power button for one second.

A message appears asking if you want to join the last class the clicker was connected to or find a different class.

2. Use the soft keys to join the last class.

OR

Use the soft keys to find a class, and then select the class.

**NOTE**

If you have multiple receivers connected to your computer, students see multiple class names that are numbered to identify each receiver. For example, Math(1 and Math(2.

Assign an equal number of students to each class to ensure optimum performance.

A connecting message appears, followed by a message asking for an ID number.

3. Press the number buttons to enter your ID number, and then press the soft key to sign in.

If the ID is valid, a message appears asking you to confirm your name.

**NOTE**

If the teacher selected the Lock Sign In option, a message appears on the clicker indicating that the student can't sign in at this time, and then a Retry option appears.

4. Press the soft key to connect.

A welcome message appears.
**NOTE**

If a student attempts to sign in using an ID that another student is already using, a message appears indicating that they’re unable to sign in and lets them retry.

---

**To connect LE clickers in Sign In mode**

Tell your students to press their clicker’s **Power** button for one second.

A "Hello" message appears on the clicker display.

When all of your students are connected, you can start asking questions. Refer to *Creating assessments* on page 44 for information about using SMART Notebook software to ask questions and create assessments.

---

**To connect Internet-enabled devices in Sign In mode**

When you start an assessment in VE mode, an **Assessment Started** message appears showing the SMART Response VE website URL and the Assessment ID. Record this information, and then tell your students to follow this procedure.

1. Open an Internet browser and connect to `response.smarttech.com`.
   
   The **SMART Response VE** login dialog box appears.

2. Type the Assessment ID and Student ID into the appropriate text boxes, and then click **Sign In**.
   
   The question appears on the student’s screens.

---

**To connect SMART Notebook SE in Sign In mode**

After you start a class, tell your students to sign in by following the procedure described in the SMART Notebook SE online Help system.

---

**Manually connecting to a class**

---

**IMPORTANT**

You can perform this procedure only if SMART Response software is in CE mode.

After you start a class, students can connect to it automatically by following the steps in the SMART Notebook SE online Help system. Students can also connect manually by entering your class’s Internet Protocol (IP) address and port number.

The following procedure explains how to find this information so you can provide it to your students.
To find your class's IP address and port number

   
   Teacher Tools appears.

2. Ensure that your class is started.

3. Click Connect students manually on the Home tab.
   
   The Manual Connection Information screen appears and displays your class's IP address and port number.

Locking sign-in
You can block students from signing in to your class. Select the Lock Sign In button to block students from signing in before you’re ready or to block late students from signing in. When you start a class, sign-in is unlocked by default. If you stop and restart SMART Response software or open a new class list, sign-in unlocks.

**NOTES**
- In PE, LE and XE modes, you can lock sign-in only in Sign In mode.
- In CE mode, you can lock sign-in in Sign In and Anonymous modes.
- You are unable to lock sign-in in VE mode.

To block students from signing in

   
   Teacher Tools appears.

2. If a class isn't already started, select a class in the Gradebook area, and then click Start Class.

3. Click Lock Sign In.
   
   Students are unable to sign in.

**NOTE**
If students disconnect from your class when sign-in is locked, they’re unable to sign in again until you click Unlock Sign In.
Disconnecting students from a class
You can disconnect students from a class in three ways. You can disconnect them simultaneously, disconnect individual clickers using Teacher Tools or students can manually disconnect.

**NOTE**
You can't disconnect students using Teacher Tools when in VE mode.

Disconnected all students
You can disconnect all students simultaneously.

**To disconnect all students by stopping the class**
Select Response > Stop Class in the SMART Notebook menu bar.

- All clicker-connected students disconnect, and a message appears on their clickers indicating that the class is over and that the clickers are turning off. The Transmit and Receive lights on the receiver turn off and the Ready light turns red.
- All SMART Notebook SE software-connected students disconnect from the class, and a message appears stating “All students are signed out”.

Disconnected individual clickers using Teacher Tools

**NOTE**
This option is available only if the students are connected to a class in Sign In mode.

**To disconnect individual clickers using Teacher Tools**

2. Select the active class in the Gradebook area.
3. Click the Students tab.
4. Select the row of the student you want to disconnect.
   The Properties window appears below the student list table.
5. Click Disconnect Clicker at the top-right corner of the window.
   The Log Off Student dialog box appears.
6. Click OK to disconnect the student.

**NOTE**
The student can log back on immediately.

If you don't want the student to be able log on for a while, select Also ban this student for, select the number of minutes, and then click OK.

**Students disconnecting manually**
Students with SMART Response clickers can disconnect them by pressing the Power button for one to two seconds.

If signed-in students turn off their clickers when a question set is started, they can turn on the clickers, sign in with the same ID and join the assessment in progress without losing any previous answers. If students are connected anonymously, they lose any previous answers when they reconnect.

**To disconnect after connecting to the wrong class**

<table>
<thead>
<tr>
<th>Tell students using</th>
<th>to disconnect by</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE clickers</td>
<td>pressing the Menu button, selecting Sign out and then pressing the Enter button.</td>
</tr>
<tr>
<td>XE clickers</td>
<td>pressing the Sym button, pressing SPACEBAR, and then selecting Log Out. They can then connect and sign in to the correct class without turning off their clickers.</td>
</tr>
<tr>
<td>LE clickers</td>
<td>turning off their clickers. They can then turn them back on to connect.</td>
</tr>
<tr>
<td>SMART Notebook SE software</td>
<td>clicking Disconnect, and then signing in to the correct class.</td>
</tr>
<tr>
<td>Internet-enabled devices</td>
<td>connecting to response.smarttech.com, and then signing in to the correct assessment.</td>
</tr>
</tbody>
</table>

**TIP**
For more information on how students connect to SMART Response CE classes using SMART Notebook SE software, see the SMART Notebook SE online Help.

In Sign In mode, if students disconnect during an assessment, they can sign in with the same ID to join the assessment without losing the answers they previously entered. In Anonymous mode, students lose any previously entered answers when they reconnect.
Completing assessments

After you create an assessment, you can start it in SMART Response software. Students then complete the assessment. During the assessment, you can view results.

Starting an assessment

When you use SMART Notebook software to ask questions, SMART Response software uses the options you set in Teacher Tools to control how students interact with the teacher. If students are using clickers, before starting a SMART Response assessment, check that the receiver is connected and ready. If you don’t have a SMART Notebook assessment file, you must create one. See Creating an assessment on page 44 for more information.

To open an assessment and set options

1. Click the SMART Response icon in the Windows notification area or Mac menu bar, and then select Open Notebook Software.
   A blank SMART Notebook page appears.
2. Select File > Open.
3. Select the SMART Notebook file containing your questions, and then click Open.
   The assessment file's title page appears.
4. Click the Response tab, and then click Properties if it isn't already selected.
5. Select one of the following options to set the Assessment Delivery mode.

**NOTE**

The Assessment Delivery mode options are available only in PE, XE or Multiple SMART devices mode.

<table>
<thead>
<tr>
<th>Allow students to answer...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All questions at their own pace.</td>
<td>This is the default mode. Students that have access to the assessment can answer questions as quickly or slowly as they want.</td>
</tr>
<tr>
<td>The currently displayed question only.</td>
<td>Teachers must start each question, wait for student responses, and then stop the question before they can move to another question. This mode allows teachers to control the progress of the assessment while monitoring how students answer each question. The toolbar Start Assessment icon changes to a Start Question icon.</td>
</tr>
</tbody>
</table>

6. Select the Remember names check box to display student names in the Response tab during the assessment.

OR

Clear the Remember names check box to hide student names in the Response tab during the assessment.

**NOTES**

- Select the Remember names check box if you want to identify students when you review results during the assessment.
- Clear the Remember names check box if you want to display the SMART Notebook file on a SMART Board interactive whiteboard during the assessment but don’t want students to see each other’s results.
- You can review, print and export the results after the assessment even if you clear the Remember names check box.
7. Select one of the following options from the *Show results to students* drop-down list:

<table>
<thead>
<tr>
<th>Feedback option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After you stop collecting responses</td>
<td>Students can see how they answered and see their grades after you click <strong>Stop</strong>. If you select this option, you can also choose to show the correct answers with grades and show the class average.</td>
</tr>
<tr>
<td>After all questions are answered</td>
<td>Students can see how they answered and see their grades after they finish answering all questions. If you select this option, you can also choose to show the correct answers with grades and show the class average.</td>
</tr>
<tr>
<td>After each question is answered</td>
<td>Students can see how they answered each question and see their grades after they finish answering all questions. If you select this option, you can also choose to show the correct answers with grades and show the class average.</td>
</tr>
<tr>
<td>Don’t show students their grades</td>
<td>Students can’t see how they answered or see their grades.</td>
</tr>
<tr>
<td>Don’t allow students to save assessment</td>
<td>Students using SMART Notebook SE software can’t save the assessment to their binders after they finish.</td>
</tr>
</tbody>
</table>

**NOTE**

The feedback options available vary depending on the SMART Response mode.

---

**To start an assessment and ask questions in PE, XE and CE modes**

1. Start a class now, if you haven’t already done so.
2. Have your students connect to the class, if they haven’t already done so.
3. Select **Response > Start Assessment**.
   
   The **Response** tab opens with the **Progress** button selected.
   
   If you’re displaying the questions on a screen, you can control the students’ progress by selecting each question page in turn.
4. Use the **Forward** or **Back** buttons on the menu bar to open a question page.
   
   OR
   
   Click the **Page Sorter** tab, and then select the thumbnail of a question page.
5. Click **Response > Stop Assessment** in the menu bar to end the session.
6. If you chose to show results to students, select **Response > End Review Mode** when the
7. Click **Save** to save the results.

### To start an assessment and ask questions in LE mode

1. Start a class now, if you haven't already done so.
2. Have your students connect to the class, if they haven't already done so.
3. Select **Response > Start Assessment**.
   
   The **Response** tab opens with the **Progress** button selected.

   If you're displaying the questions on a screen, you can control the students’ progress by selecting each question page in turn.

4. Use the **Forward** or **Back** buttons on the menu bar to open a question page.
   
   OR

   Click the **Page Sorter** tab, and then select the thumbnail of a question page.

5. Click **Start Question** on the toolbar.

   The **Response** tab opens with the **Progress** button selected.

6. Ask your students to answer the question with their clickers.

7. When the "All the students have answered" message appears in the **Response** tab, click **Stop Question**.

   A chart showing your students’ results and several options appears in the **Response** tab. Select the options you want.

8. Repeat steps 4 through 7 for each question in your assessment.

   **NOTE**

   You must stop the current question before you can ask another question.

9. Click **Response > Stop Assessment** in the menu bar to end the session.

10. If you chose to show results to students, select **Response > End Review Mode** when the students are done reviewing their results.

11. Click **Save** to save the results.
To start an assessment and ask questions in VE mode

1. Start a class, if you haven't already done so.

2. Select Response > Start Assessment.

   The Assessment Started dialog box appears displaying the URL and Assessment ID that the
   students need to connect to the assessment.

   The Response tab opens with the Progress button selected.

3. Tell your students to browse to response.smarttech.com, and then enter their Student IDs
   and the Assessment ID.

   The assessment appears on their browsers.

4. When all your students are connected, click OK to close the Assessment Started dialog box.

5. Use the Forward or Back buttons on the menu bar to open a question page.

   OR

   Click the Page Sorter tab, and then select the thumbnail of a question page.

6. Click Response > Stop Assessment in the menu bar to end the session.

7. Click Save to save the results.

Collecting question responses

**NOTE**

Make sure that you start your class and that all the students using clickers are connected before
you ask questions.

To collect question responses

1. Select Response > Start Assessment.

   If you haven’t started a class, a message appears asking you to select a class. Select a class,
   and then click Start Class.

   A message appears on the clickers asking the students to respond.
2. After all students answer the questions, select Response > Stop Assessment.

**NOTE**
SMART Notebook software stores the results in your document. Remember to save your document after you collect responses.

3. If you want to save the questions as a SMART Notebook file, select File > Save (or Save As).

   A Save As dialog box appears.

4. Browse to a destination folder, type a file name, and then click Save.

**Reviewing results after an assessment**
You can use SMART Response software to collect and display results instantly after you run an assessment. You can use assessments as an interactive learning tool and as a way to give students continual feedback on what they're learning.

**To display instant class assessment results**

1. After all students answer the questions, return to the assessment's title page.

2. Click SMART Notebook's Response tab if it isn't already open.

3. Select Progress > Stop this assessment.

   The Progress button changes to Results. A summary of the class's performance appears, including a chart showing the class's responses to each question.

4. If you want to view more detailed class results, click Show beside Details.

   A list of students, their grades and the duration of the assessment appears.

**IMPORTANT**

Use discretion when displaying sensitive grade information to all class members. If you started the class in Sign In mode, consider clearing the Remember names check box before you start the assessment to hide student names in the Response tab. (You can later review, print and export the results in Teacher Tools.)

**NOTE**

If you start the class in Anonymous mode or clear the Remember names check box before you start the assessment, student names display as Anonymous-1, Anonymous-2, and so on.
To display instant results for each question

1. After all students answer the questions, return to the assessment’s title page.
2. Click SMART Notebook software’s **Response** tab if it isn’t already open.
3. Select **Progress > Stop this assessment**
   
   The Progress button changes to Results. A chart representing the class’s performance appears.
4. Click the **Page Sorter** tab, and then select a question.
5. Click the **Response** tab.
6. Click **Results**
   
   A summary of the class’s responses to the question appears, including a chart showing the number of responses to each possible answer.

### TIPS

- You can change the type of chart displayed by selecting **Show bar chart** or **Show pie chart**.
- You can insert the chart into the question page by clicking **Insert chart into Notebook**.

7. Click **Show** beside **Details**.

   A list showing each student’s submitted response appears, including the time it took to respond.

### IMPORTANT

Use discretion when displaying sensitive grade information to all class members. If you started the class in Sign In mode, consider clearing the **Remember names** check box before you start the assessment to hide student names in the **Response** tab. (You can later review, print and export the results in Teacher Tools.)

### NOTE

If you start the class in Anonymous mode or clear the **Remember names** check box before you start the assessment, student names display as **Anonymous-1, Anonymous-2**, and so on.
**Previewing results during an assessment**

You can use SMART Response software to display results instantly while you run an assessment. You can use assessments as an interactive learning tool and a way to give students continual feedback on what they're learning.

**IMPORTANT**

You must have two or more students participating in your assessment to use this feature.

**To preview class assessment results**

1. Start your assessment, if it isn't already running.
2. Display the question using the **Page sorter** or the left and right arrows.
3. Click SMART Notebook software's **Response** tab, and then select the **Progress** button.
4. Click **Show** beside **Results Preview**.

A chart showing the class’s current responses to the question appears.

**NOTES**

- The chart changes as students answer the question, and changes as students change their answers.
- Select the assessment’s title page to preview a summary of the progress of all the assessment’s questions. You can use this chart to see how much of the assessment the class has completed.
Chapter 5
Using clickers

About SMART Response PE clickers .......................................................... 88
  Changing SMART Response PE clicker settings ...................................... 88
  Changing the clicker’s language .............................................................. 89
  Answering yes or no questions .............................................................. 89
  Answering true or false questions ......................................................... 89
  Answering multiple choice questions .................................................... 90
  Answering multiple answer questions ................................................. 90
  Answering number, fraction or decimal questions ................................... 91
  Answering text answer questions ......................................................... 92
About SMART Response LE clickers ......................................................... 93
  Clicker buttons .................................................................................. 93
  Using the Teacher mode menu ............................................................ 94
About SMART Response XE clickers ......................................................... 95
  Clicker buttons .................................................................................. 95
  Asking questions .............................................................................. 96

After students connect their clickers to your class, they can use their clickers to complete assessments.

In addition, students using SMART Response PE or XE clickers can ask questions using their clickers and change their clicker settings.
About SMART Response PE clickers

Changing SMART Response PE clicker settings
Students can press the **Menu** button at any time to log off the session or to modify the clicker’s settings. These options are available in the menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign out</td>
<td>Press to log off a class without turning off the clicker.</td>
</tr>
<tr>
<td>Language</td>
<td>Press to select French or English language text on clicker’s display. See <a href="#">Changing the clicker’s language</a> on the next page.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Press to brighten or darken the clicker’s LCD display. Use the selection buttons to increase or decrease the contrast.</td>
</tr>
<tr>
<td>Device info</td>
<td>Press to display the clicker’s MAC address and firmware version.</td>
</tr>
<tr>
<td>Advanced</td>
<td>You must have a valid security code to open this menu. Your customer support representative can provide the code to help troubleshoot clicker problems.</td>
</tr>
</tbody>
</table>
Changing the clicker’s language
Students can change the language of their SMART Response PE clickers by performing the following procedure.

■ To change the clicker’s language

1. Turn the clicker on.
2. Press the clicker’s Menu button.
3. Browse to Language using the Up and Down buttons, and then press Enter.
4. Select the language using the Up and Down buttons, and then press Enter.

The clicker returns to the Welcome display in the language you selected.

Answering yes or no questions
Students can answer yes or no questions using the following two buttons on their clickers:

NOTE
These are the same buttons students use to answer true or false questions.

Answering true or false questions
Students can answer true or false questions using the following two buttons on their clickers:

NOTE
These are the same buttons students use to answer yes or no questions.
Answering multiple choice questions
Students can answer multiple choice questions using the following buttons on their clickers:

EXAMPLE
To answer C, a student would press \( \text{def.} \)

Answering multiple answer questions
Students can answer multiple answer questions using the following buttons on their clickers:

EXAMPLE
To answer A and C, a student would press \( \text{def.} \) and then press \( \text{def.} \)
Answering number, fraction or decimal questions

Students can enter numbers using the following buttons on their clickers:

- **To enter a decimal number**
  1. Enter the numbers to the left of the decimal point.
  2. Press \( \cdot \).
  3. Enter the numbers to the right of the decimal point.

- **To enter a fraction**
  1. Enter the numerator.
  2. Press \( \cdot \).
  3. Enter the denominator.

- **To enter a mixed fraction**
  1. Enter the whole number.
  2. Press \( \cdot \).
  3. Enter the numerator.
  4. Press \( \cdot \).
  5. Enter the denominator.

- **To change a number from positive to negative (or vice versa)**
  Press \( \cdot \).
Answering text answer questions

Students can answer text questions using the following buttons on their clickers:

Responding to text answer questions on a SMART Response PE clicker is similar to texting on a cell phone.

**EXAMPLE**

To respond "iron", a student would do the following:

1. Press \[ D \] three times to enter \( i \).

2. Press \[ E \] three times to enter \( r \).

3. Press \[ F \] three times to enter \( o \).

4. Press \[ J \] two times to enter \( n \).

**IMPORTANT**

Text answers are case sensitive. If the only acceptable answer to a text answer question is "Iron", students must enter "Iron" and not "iron" or "IRON". To change to uppercase, students press \[ + \] on their clickers.

**To enter a space**

Press \[ \text{space} \].
To make a change

1. Use the arrow buttons to move the cursor to the character you want to change.
2. Press the Delete button to delete the character.
3. Enter a new character.

About SMART Response LE clickers

The students use only the Power, selection and answer buttons. The other buttons are for Teacher mode.

Clicker buttons

<table>
<thead>
<tr>
<th>Clicker button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Press for one second to turn on the clicker. Press for one to two seconds to turn off the clicker.</td>
</tr>
</tbody>
</table>
CHAPTER 5
Using clickers

<table>
<thead>
<tr>
<th>Clicker button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection</td>
<td>Scroll through option lists.</td>
</tr>
<tr>
<td>Enter</td>
<td>Make or confirm a selection.</td>
</tr>
<tr>
<td>Ask Question</td>
<td>Displays the clicker ID.</td>
</tr>
<tr>
<td>Menu</td>
<td>Press with the Power button to open the clicker menu in Teacher mode. See Using the Teacher mode menu below.</td>
</tr>
<tr>
<td>Answer</td>
<td>Five colored buttons with geometric shapes to answer questions.</td>
</tr>
</tbody>
</table>

Using the Teacher mode menu

To put SMART Response LE clickers into Teacher mode

Press the Power and Home buttons simultaneously.

**NOTE**
You can press the Home button by itself without any effect.

Press the Enter button to make your selections. Press the Home button to return to the primary menu.

The following options are available in the Teacher mode menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan &amp; Pick</td>
<td>Pair the clicker with your receiver during setup.</td>
</tr>
<tr>
<td>Show Rcv PID</td>
<td>Display the current Pan ID.</td>
</tr>
<tr>
<td>Clicker ID</td>
<td>Set the Clicker ID.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Lightens or darkens the clicker’s LCD display. Use the up and down arrows to increase or decrease the contrast.</td>
</tr>
<tr>
<td>Device Info</td>
<td>Display the clicker’s MAC address and firmware version.</td>
</tr>
<tr>
<td>Restore Default</td>
<td>Restore the clicker’s factory default settings.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit Teacher mode to connect to the class.</td>
</tr>
</tbody>
</table>
About SMART Response XE clickers

Clicker buttons

<table>
<thead>
<tr>
<th>Button/key name</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button</td>
<td></td>
<td>Press and hold to turn clicker on or off.</td>
</tr>
<tr>
<td>Soft keys</td>
<td></td>
<td>Press to select functions displayed on the LCD display. The functions depend on the clicker’s mode. Press to answer multiple choice, multiple answer, true/false and yes/no questions.</td>
</tr>
<tr>
<td>Letter and number keys</td>
<td></td>
<td>Press to insert lowercase value. Press while holding the Shift key to insert an uppercase value. Press and hold a, e, i, o, u, y, c or n keys to select other character variations.</td>
</tr>
<tr>
<td>Symbol key</td>
<td>Sym</td>
<td>Press and release to select green key functions. Press and hold to display a menu where you can select symbols.</td>
</tr>
</tbody>
</table>
### Asking questions

At any time during a class, students using SMART Response PE or XE clickers can request the teacher's attention.

- Students using SMART Response PE clickers can press the **Ask Question** button.
- Students using SMART Response XE clickers can press the **Sym** button, press the spacebar, and then select **Raise hand**.

Teacher Tools displays the number of students who have questions on the **Home** tab beside the **Questions** heading.

#### To identify students with questions

1. Click the **Students** tab in **Teacher Tools Gradebook** to show the list of student names and IDs. In the **Status** column, you might see one or more rows with a question icon 📘.

2. If you've answered a student's question, select the row that displays the student's name, and then click the **Clear Question** icon in the top-right corner of the **Properties** window.
Chapter 6
Reviewing, printing and exporting assessment results

Importing assessment results ........................................................................................................... 98
  Formatting the results files for importing ...................................................................................... 98
  Importing a class results file ......................................................................................................... 98
  CSV and XLS file formatting .......................................................................................................... 99
Reviewing assessment results ........................................................................................................... 100
Flagging results ................................................................................................................................. 102
Generating Student Performance reports ...................................................................................... 103
  Choosing a report ........................................................................................................................ 103
    Student Performance report .................................................................................................... 103
    Student Comparison report .................................................................................................... 104
Generating Class Performance reports .......................................................................................... 105
  Choosing a report ........................................................................................................................ 106
    Class Performance report .................................................................................................... 106
    Class Comparison report .................................................................................................... 106
Printing and exporting questions and results .................................................................................. 108
  Printing from SMART Notebook software's Response menu ..................................................... 108
  Exporting results ........................................................................................................................ 109

The Teacher Tools Gradebook gives you quick access to test results, making it easy to prepare reports and conduct evaluations. Reports can be as simple or as detailed as you need. You can create high-level comparisons of class performance, specific reports based on tagged characteristics such as demographics or curriculum standard and personalized reports on how individual students perform. You can also create reports that show grades for the entire school year.

You can display results and generate reports to review during an assessment or after you run an assessment. In addition, you can print or export questions and assessment results.

NOTE
Assessment results for students aren't saved in Anonymous mode.
Importing assessment results

You can import the results of an assessment that you performed without using your SMART Response system. You can then generate reports that combine the results from your assessments with the imported results.

You can import results using either comma separated values (CSV) files or Microsoft Excel files (Windows operating systems only).

**NOTE**

The ID numbers you use in the list you import must match the ID numbers assigned to the students in the class list that you’re using.

Formatting the results files for importing

You must use the headings **ID Number** and **Marks** when you format the CSV, XLS or XLSX file for importing. If you’re using information from another program, copy it to a new file and then format it as shown in **CSV and XLS file formatting** on the next page.

Importing a class results file

You can import a class results file using Teacher Tools.

To import a class results file

1. Start Teacher Tools. See **Starting Teacher Tools** on page 25.

   *Teacher Tools* appears.

2. In the *Gradebook* area, select the class you want to import the results to.

3. Click *Import* on the menu bar, and then select *Assessments*.

4. Click the target class, and then click *Next*.

5. Type the title, and then select the type of the assessment. Optionally, type the subject and topic information.

6. Select the **Percentage** or **Raw values** score formats, and then click *Next*.

7. Select the file type, and then click *Next*.
8. Browse to and select the file, and then click **Open**.

The student results information appears in the **Students** and **Assessments** tabs. You can also generate reports that include the imported scores.

**CSV and XLS file formatting**

**EXAMPLE**

Comma separated values (CSV) file

<table>
<thead>
<tr>
<th>ID Number</th>
<th>Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>8781</td>
<td>33</td>
</tr>
<tr>
<td>8727</td>
<td>32</td>
</tr>
<tr>
<td>8534</td>
<td>18</td>
</tr>
<tr>
<td>2504</td>
<td>22</td>
</tr>
<tr>
<td>8759</td>
<td>29</td>
</tr>
<tr>
<td>8753</td>
<td>35</td>
</tr>
<tr>
<td>8815</td>
<td>25</td>
</tr>
<tr>
<td>8811</td>
<td>28</td>
</tr>
<tr>
<td>8716</td>
<td>26</td>
</tr>
</tbody>
</table>

**EXAMPLE**

Excel spreadsheet (XLS) file

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID Number</td>
<td>Marks</td>
</tr>
<tr>
<td>----</td>
<td>------</td>
</tr>
<tr>
<td>1</td>
<td>8781</td>
</tr>
<tr>
<td>2</td>
<td>8727</td>
</tr>
<tr>
<td>3</td>
<td>8534</td>
</tr>
<tr>
<td>4</td>
<td>2504</td>
</tr>
<tr>
<td>5</td>
<td>8759</td>
</tr>
<tr>
<td>6</td>
<td>8753</td>
</tr>
<tr>
<td>7</td>
<td>8815</td>
</tr>
<tr>
<td>8</td>
<td>8811</td>
</tr>
<tr>
<td>9</td>
<td>8716</td>
</tr>
</tbody>
</table>
Reviewing assessment results

After you run and stop an assessment, Teacher Tools records the class results and each student's results. At any time after you run an assessment, you can review the student, question or assessment results and performance. If you ask a series of questions consecutively, their results are aggregated so that you can review them as a single assessment.

**NOTE**

Use discretion when displaying sensitive information to all class members. To hide sensitive information, click the Privacy: Off indicator before you display student or assessment results. See Adjusting privacy and alert options on page 27 for more information.

**To display student results**

1. If a class is running, stop it.

2. In Teacher Tools, select the class name in the Gradebook area.
   
The class window appears with the Home tab selected.

3. Click the Students tab.
   
   After a short delay, a table of results appears. If you previously turned on Privacy mode, the student IDs and average scores appear as gray shapes in the table.

4. If Privacy mode is on, click the Privacy: On indicator.
   
The columns of the table of class results show the student names, ID and average score for all the assessments each student has participated in.

**To display detailed results for each student**

1. Complete the above procedure, and then select the student's row.
   
The student's information appears in the lower pane.

2. Click the Performance tab.
   
   An Assessment Results over Time graph appears showing the student's results compared to the class average for all assessments since the first assessment was run.

**NOTE**

The graph is hidden when Teacher Tools is in Privacy mode.

3. Place your pointer over the graph to display details about the specific assessment.
4. Click the **Results** tab.

   A table appears showing detailed information about each assessment the student has participated in, including the date and the score the student achieved. If the student’s score is below the passing grade you defined when you created the class, the score appears in red. See *Changing a class’s passing grade* on page 39 for information.

**To display class assessment results**

1. If a class is currently running, stop it.

2. In *Teacher Tools*, select the class name in the *Gradebook* area.

   The class window appears with the *Home* tab selected.

3. Click the **Assessments** tab.

   After a short delay, a table of results appears listing all assessments that the class has participated in, including the class average score for each assessment. If the class average score is below the passing grade you defined when you created the class, the score appears in red. See *Changing a class’s passing grade* on page 39 for information.

**To display detailed results for each assessment**

1. Complete the previous procedure, and then select the assessment's row.

   The lower pane of the window displays the assessment's properties.

2. Click the **Performance** tab.

   A *Student Achievement per Question* graph appears showing the student responses to each question.

   **NOTE**

   The graph is hidden when Teacher Tools is in Privacy mode.

3. Place your pointer over the graph to display details about the specific questions.

4. Click the **Results** tab.

   A table appears showing the mark each student received for the assessment. If the student's score is below the passing grade you defined when you created the class, the mark appears in red.
To display and change results for each question in an assessment

1. If a class is running, stop it.

2. In Teacher Tools, select the class name in the Gradebook area.
   The class window appears with the Home tab selected.

3. Click the Assessments tab.
   After a short delay, a table of results appears listing all assessments that the class has participated in.

4. Select the row for the assessment you want to display.

5. Click the Questions tab.
   A list of the assessment’s questions appears showing the student responses to each question.

6. If you want to change an answer to be graded as correct or incorrect, select the question you want to change, and then select or clear the Correct checkbox.
   The student grades and the class average change.

Flagging results

You can add a blue flag to a student’s results as a visual reminder to follow up for any reason, for example, if a student requires remedial work. You can also clear the blue flag from the student’s results.

**NOTE**

If students are disconnected during an assessment, a Disconnected Student icon appears beside their names. To clear this flag, see Importing student responses on page 1.

To add a follow-up flag

   Teacher Tools appears.

2. Select the class the student belongs to in the Gradebook class list.
   The class information appears.

3. Click the Students tab.

4. Select the student’s name in the list.
   The student’s information appears in the lower pane.
5. Click the **Results** tab.

6. Select the assessment result you want to flag in the list.

7. Click the **Set flag** icon above the results list.
   
   A blue flag appears in the *Mark* column.

---

**To clear a follow-up flag**

1. In the **Results** tab, select the assessment result with the flag you want to clear.

2. Click the **Clear flag** icon above the results list.
   
   The flag disappears.

---

### Generating Student Performance reports

You can generate Student Performance reports any time after your assessments are complete. Some reports help you analyze student performance by educational standards and cognitive levels. Other reports enable you to compare performance between students. You can tailor the reports to include all classes or select classes only. You can choose from these report types:

- Assessment summary
- Educational standards
- Cognitive levels
- Question performance
- Performance summary

---

#### Choosing a report

**Student Performance report**

Use the following chart to help you choose your Student Performance report type.

<table>
<thead>
<tr>
<th>Assessment summary</th>
<th>Educational standards</th>
<th>Cognitive levels</th>
<th>Question performance</th>
<th>Performance summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows student and class averages for each assessment selected</td>
<td>Shows student and class averages across selected assessments for each education standard selected</td>
<td>Shows student and class averages across selected assessments for each cognitive level selected</td>
<td>Shows a table with the students' responses for each question in the selected assessments</td>
<td>Shows several charts related to student performance</td>
</tr>
</tbody>
</table>
NOTE
If you select more than one student, an individual performance report is created for each student selected.

Student Comparison report
Use the following chart to help you choose your Student Comparison report type.

<table>
<thead>
<tr>
<th>Assessment summary</th>
<th>Educational standards</th>
<th>Cognitive levels</th>
<th>Question performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the averages for the selected students for each assessment selected</td>
<td>Shows the averages for the selected students across selected assessments for each education standard selected</td>
<td>Shows the averages for the selected students across selected assessments for each cognitive level selected</td>
<td>Shows a table with the selected students’ responses for each question in the selected assessments</td>
</tr>
</tbody>
</table>

To generate a student performance report


   Teacher Tools appears.

2. In the Reports area, click Student Performance.

NOTE
If you want to generate a report comparing student performance, select Student Comparison.

The Student Performance window appears.

3. Select the type of report you want from the Choose a report type list.

4. Select a specific class or All classes from the Choose report parameters Classes drop-down list.

5. If you want to include specific students in your report, click Change, and then select the students.

6. If you want to include specific assessments in your report, click Change, and then select the assessments.

7. If the Educational standards or Cognitive levels headings appear, click Change, and then select the options you want to include.
8. If the Show heading appears, select the type of chart you want to display.

9. Select one of the following options:

   - **Preview**: A Preview window appears showing the report with one page for each student selected.
   - **Save Report**: After prompting you to name the report, Teacher Tools saves the report so that you can view or process it later.
   - **Export**: After you select the student name and ID formatting, the report saves as a comma-separated values (CSV) file to your desired folder.
   - **Create PDF**: Saves the report as one or more .pdf files to your desired folder. A unique .pdf file is created for each student selected.

---

**Generating Class Performance reports**

You can generate Class Performance reports any time after your assessments are complete. Some reports help you analyze class performance by educational standards and cognitive levels. Other reports allow you to compare performance between classes. You can tailor the reports to include all classes or select classes only. You can choose from these report types:

- Assessment summary
- Educational standards
- Cognitive levels
- Question performance
- Performance summary
Choosing a report

Class Performance report
Use the following chart to help you choose your Class Performance report type.

<table>
<thead>
<tr>
<th>Assessment summary</th>
<th>Educational standards</th>
<th>Cognitive levels</th>
<th>Question performance</th>
<th>Performance summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the class averages for each assessment selected</td>
<td>Shows the class average across selected assessments for each education standard selected</td>
<td>Shows the class average across selected assessments for each cognitive level selected</td>
<td>Shows the percentage of students that answered correctly or incorrectly for each question in the selected assessments</td>
<td>Shows several charts related to class performance</td>
</tr>
</tbody>
</table>

**NOTE**
If you select more than one class, an individual performance report is created for each class selected.

Class Comparison report
Use the following chart to help you choose your Class Comparison report type.

<table>
<thead>
<tr>
<th>Assessment summary</th>
<th>Educational standards</th>
<th>Cognitive levels</th>
<th>Question performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the averages for the selected classes for each assessment selected</td>
<td>Shows the averages for the selected classes across selected assessments for each education standard selected</td>
<td>Shows the averages for the selected classes across selected assessments for each cognitive level selected</td>
<td>Shows the percentage of students that answered correctly in each of the selected classes for each question in the selected assessments</td>
</tr>
</tbody>
</table>

**NOTE**
Only assessments that are common between classes appear in the Select Assessments dialog box. The assessments you want to compare between classes must have the same Title, Subject, Topic and Type.
To generate a Class Performance report

   
   Teacher Tools appears.

2. In the Reports area, click Class Performance.

   **NOTE**
   
   If you want to generate a report comparing class performance, select Class Comparison.

   The Class Performance window appears.

3. Select the type of report you want from the Choose a report type list.

4. Select a specific class or All classes from the Choose report parameters Classes drop-down list.

5. If you want to include specific assessments in your report, click Change, and then select the assessments.

6. If the Educational standards or Cognitive levels headings appear, click Change, and then select the options you want to include.

7. If the Show heading appears, select the type of chart you want to display.

8. Select one of the following options:

   - **Preview**  
     A Preview window appears showing the report.

   - **Save Report**  
     After prompting you to name the report, Teacher Tools saves the report so that you can view or process it later.

   - **Create PDF**  
     Saves the report as a .pdf file to your desired folder.
Printing and exporting questions and results

Using SMART Notebook software’s Response menu, you can create hard copies of questions, handouts and student results. You can also export questions and student results to an Excel spreadsheet, a comma separated values (CSV) file or an HTML web page.

Printing from SMART Notebook software’s Response menu

You can print a variety of information from the Response menu in SMART Notebook software. You can create and include header, footer and date information, and select a page range to print.

<table>
<thead>
<tr>
<th>Print option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnails</td>
<td>On one page, print up to six full-color, reduced images of SMART Notebook pages. You can include page numbers, image borders and page titles.</td>
</tr>
<tr>
<td>Handouts</td>
<td>On one page, print up to three full-color, reduced images of SMART Notebook pages, with ruled lines for notes. You can include page numbers, image borders and page titles.</td>
</tr>
<tr>
<td>Full page</td>
<td>On one page, print a full-color image of a SMART Notebook question page. You can include page numbers.</td>
</tr>
<tr>
<td>Questions</td>
<td>Print several questions on a page. If the question page doesn't have any objects or images, only the text appears. If there are objects on the question page, a full-color thumbnail of the question appears. You can include page numbers.</td>
</tr>
<tr>
<td>Results</td>
<td><strong>NOTE</strong> This option is available only after you stop your assessment.</td>
</tr>
</tbody>
</table>

Print several questions on a page. If the question page doesn't have any objects or images, only the text appears on the page. If there are objects on the question page, a full-color thumbnail of the question appears. In the *Print Preview* view, you can click the question to toggle from thumbnail to text-only format.

The correct answer and the student’s response appear beside each question, and the total score appears at the top of the first page. You can include page numbers.

You can print a summary of the results for all students in the class list or for selected students.
To print questions or results

Select Response > Print, and then select the print option you want.

OR

For other options, select Response > Print > More Print Options to open SMART Response software’s print window.

NOTE

The Questions and Results print options are available only if the SMART Notebook file includes SMART Response questions and saved results information. If the assessment is still running, or if it stops before any student answers a question, no results are saved.

Exporting results

If you save your SMART Notebook file after you ask questions, or after you run an assessment, you can open the SMART Notebook file at any time to view the results.

You can export the results to an Excel spreadsheet (Windows only), to an HTML page for viewing on a web browser or to a comma separated values (CSV) file that you can import into many spreadsheet and database applications. See CSV and XLS file formatting on page 99. You can also export the results to a third-party gradebook in one of the predefined formats, or you can create a custom format.

NOTE

You can export results only after you stop the assessment. If you clear the results after you stop, the results are permanently deleted and you’re unable to print or export them. After you save and close the SMART Notebook file, you can open the file and print or export the results.
To export results from Teacher Tools


   Teacher Tools appears.

2. Select File > Export from the menu bar.

   The Export dialog box appears.

3. In the list, select the class with the results you want to export, and then click Next.

4. Select one of the following options:

   - Select the By student option if you want to export results for your entire class (the default selection) or for an individual student. If you want to export results for an individual student, also select the student’s name from the drop-down list.
   - Select the By assessment option if you want to export the results of a class assessment or all assessments the class has taken.
   - Select the To another gradebook format option if you want to export the results to a third-party gradebook.

   **NOTE**

   If you select the CSV file format, you can customize the format to be compatible with your third-party gradebook. SMART Response software saves the customized format so that you don’t have to customize the format each time you export the results.

5. Click Next.

6. Select the format you want to export the results in, and then click Next.

   The Save As dialog box appears.

7. Browse to a folder, type a name for the file, and then click Save.

   The results export and open in your computer’s default file viewer.

To export results from SMART Notebook software

1. Stop the assessment if it’s running.

   **IMPORTANT**

   Do not clear the results.
2. In SMART Notebook software, select one of the following options:

- **Response > Export results to > Microsoft Excel.**

  **NOTE**
  
  Exporting to Excel isn't available on Mac computers.

- **Response > Export results to > Web Page (HTML).**

- **Response > Export results to > Comma Separated Values (CSV).**

  The **Save As** dialog box appears.

3. Browse to a folder, type a name for the file, and then click **Save**.

  Either Excel or your default web browser opens showing the exported file.
Chapter 7
Maintaining your SMART Response system

Preventing component damage .................................................. 113
  Cleaning the receiver and clickers .......................................... 114
  Transporting SMART Response hardware ................................. 114
Changing the clicker batteries .................................................. 114
Resetting clickers .................................................................. 115
Receiver indicator lights ........................................................... 115
Troubleshooting the receiver ..................................................... 116
  Resetting the receiver .......................................................... 116
  Interpreting the receiver indicator lights .................................. 117
Other troubleshooting tips ....................................................... 118
Troubleshooting SMART Response CE connection issues ......... 118
  Importing student responses ............................................... 119
  Finalizing disconnected students’ results in Teacher Tools ........ 119

Preventing component damage

⚠️ CAUTION

- Do not use sharp or pointed objects, such as ballpoint pens or pointers, to press the clicker buttons.
- Do not use abrasive erasers or harsh chemicals to clean the receiver or clickers.
- Avoid setting up and using your system in an area with excessive levels of dust, humidity or smoke.
Cleaning the receiver and clickers
With proper care, your SMART Response hardware will provide years of trouble-free performance. Follow these cleaning tips to maintain your SMART Response system:

- Remove dust with a damp cloth before you use a cleaner.
- Clean the unit’s surface with a household glass cleaner, such as Windex®, daily, weekly or as required.
- Do not spray cleaner directly onto the clicker. Instead, spray a small amount of cleaner on a cloth and then gently wipe the clicker.

Transporting SMART Response hardware
If you need to ship your SMART Response hardware, repack it with as much of the original packaging as possible. If you prefer to use your own packaging materials, make sure you adequately protect the product.

Changing the clicker batteries
Under normal operating conditions, the clicker batteries can operate for up to 200 days. When you replace them, use fresh batteries of the same type and quality, and change all of them at the same time.

⚠️ CAUTION
- Do not install batteries with the polarity (+/-) reversed.
- Do not attempt to recharge the batteries.
- Do not dispose of batteries in a fire or incinerator.
- Dispose of batteries according to your region’s laws and regulations. If you don’t know the applicable rules for your region, consult your battery manufacturer.

To change the clicker batteries
1. If the clicker is on, turn it off.
2. Using the included Phillips screwdriver, remove the screw from the back of the clicker, and then remove the cover.
3. Remove all of the exhausted batteries and dispose of them according to local regulations.
4. Insert fresh batteries.
5. Replace the cover and screw.

Resetting clickers

If a clicker isn't operating as expected, you might need to reset it. Perform the following steps to reset your clicker.

To reset a clicker

1. If the clicker is on, turn it off.
2. Using the included Phillips screwdriver, remove the screw from the back of the clicker, and then remove the cover.
3. Remove the batteries.
4. Press and hold the Power button for at least five seconds.
5. Replace the batteries.
6. Replace the cover and screw.

Receiver indicator lights

Receivers have the following indicator lights:

- Ready light
- Transmit light
- Receive light

The Ready light in the corner of the receiver indicates the operational state of the receiver module. The Transmit and Receive lights flash green to indicate transmit and receive activity between the receiver and the clickers.
The following table shows the Ready light’s normal states. If the light’s behavior doesn’t match a state listed here, refer to *Troubleshooting the receiver* below.

<table>
<thead>
<tr>
<th>Ready light state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The receiver is disconnected from the computer.</td>
</tr>
<tr>
<td>Solid red</td>
<td>The receiver has power, but either it isn’t communicating with the computer or no class is started.</td>
</tr>
<tr>
<td>Solid green</td>
<td>The receiver is receiving power and communicating successfully with SMART Response software.</td>
</tr>
</tbody>
</table>

**Troubleshooting the receiver**

⚠️ **CAUTION**

Do not open the receiver or the clicker units to attempt repairs. Refer all service inquiries to authorized SMART service personnel.

**Resetting the receiver**

If your SMART Response system behaves erratically (possibly because of a static discharge or power fade), you might be able to restore normal operation by resetting the receiver.

Reset the receiver completely by disconnecting and then reconnecting the USB cable.
Interpreting the receiver indicator lights

If you experience a problem with your receiver, you can use its indicator lights to troubleshoot it.

<table>
<thead>
<tr>
<th>Ready light</th>
<th>Transmit light</th>
<th>Receive light</th>
<th>Receiver state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red, green, yellow</td>
<td>Green</td>
<td>Green</td>
<td>The receiver is starting up. Lights flash in sequence.</td>
</tr>
<tr>
<td>Flashing green</td>
<td>Off</td>
<td>Off</td>
<td>The receiver is scanning radio channels.</td>
</tr>
<tr>
<td>Flashing green</td>
<td>Any state</td>
<td>Any state</td>
<td>The receiver is accepting commands from the computer.</td>
</tr>
<tr>
<td>Green</td>
<td>Constant flashing</td>
<td>Flashes when it receives data from a clicker</td>
<td>Receiver has power and is communicating with the computer, but it isn’t receiving commands.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Off</td>
<td>Off</td>
<td>The receiver has power, but communication circuits have failed.</td>
</tr>
<tr>
<td>Flashing red</td>
<td>Flashing</td>
<td>Flashing</td>
<td>Manufacturing tests are running, and the receiver isn’t operational. All lights flash together.</td>
</tr>
<tr>
<td>Flashing yellow</td>
<td>Any state</td>
<td>Any state</td>
<td>The receiver software checksum failed.</td>
</tr>
<tr>
<td>Flashing yellow</td>
<td>Flashing</td>
<td>Flashing</td>
<td>The receiver has a software failure.</td>
</tr>
</tbody>
</table>
Other troubleshooting tips

<table>
<thead>
<tr>
<th>Symptom/observation</th>
<th>Action/remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you export SMART Response question set results from a SMART Notebook file using</td>
<td>In your exported results, change the exported dates to fractions, add a space before each fraction and convert the month to its numerical</td>
</tr>
<tr>
<td>the CSV command, fractions change to dates.</td>
<td>value. The converted month is the fraction’s numerator, and the day is the denominator.</td>
</tr>
<tr>
<td>Your computer doesn’t recognize SMART Response software, and the receiver’s Status</td>
<td>Remove the SMART Response hardware drivers on your computer, and then reconnect the receiver following the instructions in The SMART</td>
</tr>
<tr>
<td>The receiver’s Status LED flashes red when SMART Response software is in CE or VE</td>
<td>This is normal. When SMART Response software is in a mode that doesn’t require a receiver, the software doesn’t start the hardware drivers.</td>
</tr>
<tr>
<td>mode.</td>
<td></td>
</tr>
<tr>
<td>Responses from students don’t appear in SMART Notebook reports.</td>
<td>Wait at least 10 seconds after the last student responds before you stop a question set.</td>
</tr>
<tr>
<td>Additional SMART Response receivers don’t connect to the network when you install</td>
<td>Disconnect the additional receiver’s USB plug to resume normal operation. Disconnect and reconnect the first receiver’s USB plug if it</td>
</tr>
<tr>
<td>more than one receiver on your computer.</td>
<td>doesn’t work, or if the Status light turns red.</td>
</tr>
</tbody>
</table>

**NOTE**

Installing more than one receiver increases the number of clickers you can use in your classroom, but it affects your computer’s performance and doesn’t increase your reception.

Troubleshooting SMART Response CE connection issues

If students using SMART Notebook SE software are disconnected during an assessment, they can still complete the assessment offline and save their responses to a USB storage device from which you can import their answers. See Importing student responses on the next page.

If your students are disconnected from your class and aren’t able to reconnect, try the following tips.

- Ensure that the student’s network cable is properly connected to the student’s device. If it’s connected, disconnect it, and then reconnect it.
- Ensure that your own network cable is properly connected to your computer. If it’s connected, disconnect it, and then reconnect it.
- Use the Windows network connection repair utility. See your operating system’s Help system for more information.
- If your students can’t see your class in SMART Notebook SE software, try connecting them manually. See Manually connecting to a class on page 75.
- Contact your system administrator for help.

Importing student responses
If students are disconnected during an assessment, SMART Notebook SE software automatically attempts to reconnect to the class. If the software is unable to reconnect, students can still complete their assessments offline and save their responses to a USB drive from which you can import their answers. Disconnected students will be prompted to save their responses after they click Finish in SMART Notebook SE software.

To import student responses
   Teacher Tools appears.
2. Connect the student’s USB drive to your computer.
3. Select Import > Student Responses from the toolbar.
   The Select Unsent SMART Response Files dialog box appears.
4. Browse to and select the unsent response (.unsent) file, and then click Open.
   The Import dialog box appears and displays a progress bar.
5. When the import is complete, click OK.

Finalizing disconnected students’ results in Teacher Tools
If students are disconnected from your class during an assessment before they submit their responses, a Disconnected Students icon appears beside their names in the Assessments tab, indicating that their marks aren’t final. If you import a disconnected student’s responses or edit a disconnected student’s mark, the Disconnected Students icon disappears.

If you want to manually clear the icon and set the marks as final, follow the instructions below.
To set a disconnected student's mark as final

1. Start **Teacher Tools.** See **Starting Teacher Tools** on page 25.
   
   *Teacher Tools* appears.

2. Select the class the student belongs to in the **Gradebook** class list.
   
   The class information appears.

3. Click the **Students** tab.

4. Select the student's name in the list.
   
   The student's information appears in the lower pane.

5. Click the **Results** tab.

6. Select the row of the student whose mark you want to set as final, and then click the **Clear flag** icon.
   
   The icon disappears.
Appendix A

Hardware environmental compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment Regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment sold within the European Union.
When you dispose of any electrical or electronic equipment, including SMART Technologies products, we strongly encourage you to properly recycle the electronic product when it has reached end of its life. If you require further information, please contact your reseller or SMART Technologies for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances (RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous Substances (RoHS) Directive 2002/95/EC.
Consequently, this product also complies with other regulations that have arisen in various geographical areas, and that reference the European Union’s RoHS directive.

Batteries
Batteries are regulated in many countries. Check with your reseller to find out how to recycle used batteries.
There are special regulations that must be met when shipping a product that has a lithium ion battery packaged with the product or shipping a lithium ion battery. When returning a SMART Technologies
product which contains a lithium ion battery or returning a lithium ion battery, call SMART Technologies RMA for information on the special shipping regulations.

- 1.866.518.6791, Option 4 (U.S./Canada)
- 1.403.228.5940 (all other countries)

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The packaging used by SMART Technologies to ship products complies with applicable packaging laws.

Covered electronic devices
Many U.S. states classify monitors as covered electronic devices and regulate their disposal. Applicable SMART Technologies products meet the requirements of the covered electronic devices regulations.

U.S. Consumer Product Safety Improvement Act
The United States has enacted the Consumer Product Safety Improvement Act which limits the lead (Pb) content in products used by children. SMART Technologies is committed to complying with this initiative.

California Air Resources Board – Airborne Toxic Control Measure
California has enacted a law to restrict the emissions of formaldehyde from composite wood products. The SMART Technologies products that contain composite wood products are compliant to this regulation.

Restriction of Certain Chemicals (REACH directive)
The European Union has enacted the EU REACH Directive which restricts the use of certain chemicals in products. SMART Technologies is committed to complying with this initiative.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>creating a class list</td>
<td>30</td>
</tr>
<tr>
<td>Teacher Tools</td>
<td>30</td>
</tr>
<tr>
<td>CSV file formatting</td>
<td>35</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>disconnecting</td>
<td>77</td>
</tr>
<tr>
<td>all students</td>
<td>77</td>
</tr>
<tr>
<td>individual clickers using Teacher Tools</td>
<td>77</td>
</tr>
<tr>
<td>disconnecting students</td>
<td>77</td>
</tr>
<tr>
<td>manually</td>
<td>78</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>editing a class list</td>
<td>37</td>
</tr>
<tr>
<td>adding students</td>
<td>37</td>
</tr>
<tr>
<td>changing passing grades</td>
<td>39</td>
</tr>
<tr>
<td>removing students</td>
<td>38</td>
</tr>
<tr>
<td>student information</td>
<td>37</td>
</tr>
<tr>
<td>tagging</td>
<td>39</td>
</tr>
<tr>
<td>encryption methods</td>
<td>28</td>
</tr>
<tr>
<td>environmental requirements</td>
<td>9</td>
</tr>
<tr>
<td>European Union regulations</td>
<td>121-122</td>
</tr>
<tr>
<td>ExamView test exporting</td>
<td>62</td>
</tr>
<tr>
<td>exporting</td>
<td>62</td>
</tr>
<tr>
<td>ExamView tests</td>
<td>109</td>
</tr>
<tr>
<td>results</td>
<td>13</td>
</tr>
<tr>
<td>extending USB cable</td>
<td>13</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>features</td>
<td></td>
</tr>
<tr>
<td>general</td>
<td>2</td>
</tr>
<tr>
<td>hardware</td>
<td>4</td>
</tr>
<tr>
<td>flagging results</td>
<td>102</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>generating class performance reports</td>
<td>105</td>
</tr>
<tr>
<td>generating student performance reports</td>
<td>103</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>important information</td>
<td>i</td>
</tr>
<tr>
<td>importing a class list</td>
<td></td>
</tr>
<tr>
<td>CSV file</td>
<td>34</td>
</tr>
<tr>
<td>Excel</td>
<td>31</td>
</tr>
<tr>
<td>importing assessment results</td>
<td>98</td>
</tr>
<tr>
<td>importing questions</td>
<td></td>
</tr>
<tr>
<td>ExamView HTML</td>
<td>60</td>
</tr>
<tr>
<td>PDF file</td>
<td>58</td>
</tr>
<tr>
<td>setting answers</td>
<td>63</td>
</tr>
<tr>
<td>Word document</td>
<td>55</td>
</tr>
<tr>
<td>XML or SQZ file</td>
<td>57</td>
</tr>
<tr>
<td>importing student responses CE mode</td>
<td>119</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>LE clickers</td>
<td></td>
</tr>
<tr>
<td>about</td>
<td>93</td>
</tr>
<tr>
<td>using Teacher mode menu</td>
<td>94</td>
</tr>
<tr>
<td>lithium ion batteries</td>
<td>121</td>
</tr>
<tr>
<td>locking sign-in</td>
<td>76</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>maintaining</td>
<td></td>
</tr>
<tr>
<td>changing batteries</td>
<td>114</td>
</tr>
<tr>
<td>preventing damage</td>
<td>113</td>
</tr>
<tr>
<td>receiver indicator lights</td>
<td>115</td>
</tr>
<tr>
<td>resetting clickers</td>
<td>115</td>
</tr>
<tr>
<td>SMART Response system</td>
<td>113</td>
</tr>
<tr>
<td>troubleshooting the receiver</td>
<td>116</td>
</tr>
<tr>
<td>monitoring clickers</td>
<td>70</td>
</tr>
<tr>
<td>multiple SMART Response devices mode</td>
<td></td>
</tr>
<tr>
<td>limitations</td>
<td>20</td>
</tr>
<tr>
<td>selecting</td>
<td>18</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>packaging</td>
<td>122</td>
</tr>
</tbody>
</table>